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La Maná – Ecuador 

PRÓLOGO  

l presente trabajo proporciona las nociones básicas para el entendimiento y el uso de 

los sistemas de información geográfica dirigido a personas sin conocimientos 

previos, o ya iniciadas, que precisan profundizar en la utilización práctica. Por lo 

cual se recomienda el uso de este libro a todas aquellas personas que quieran iniciar 

de forma autodidactica en ESRI ArcGIS 10.2.2 y quieren alcanzar un buen nivel en 

el uso de este programa. 

En este sentido, una adecuada gestión y conocimiento de dicho territorio por parte de las 

Entidades Locales se puede convertir en un factor relevante para mejorar la gestión de este 

tipo de organizaciones y ofrecer mejores servicios a los ciudadanos, debiendo formar parte, 

necesariamente, de su sistema de información corporativo. 

Por ello, es importante dar a conocer la relevancia que el adecuado uso y explotación de la 

información geográfica representa para las Entidades Locales, logrando con ello mejorar la 

gestión de la información. 
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Introducción 

El uso de la información geográfica en la toma de decisiones suele pasar desapercibido, pero 

en realidad se encuentra presente en muchas de nuestras actividades cotidianas. Al seleccionar 

inconscientemente la ruta para ir al trabajo, la ruta de vacaciones, ir a una reunión de amigos, 

dirigirse a una tienda usando un teléfono inteligente, se están tomando decisiones que 

implican el análisis de la información geográfica sin ser conscientes de ello. Cuando este tipo 

de análisis o de toma de decisiones se lleva a cabo empleando computadoras se suele hacer 

por medio de lo que se conoce como Sistemas de Información Geográfica (SIG). 

Según López Trigal (2015) un SIG es un conjunto de herramientas compuestos por hardware, 

software, datos y usuarios, que permite capturar, almacenar, administrar y analizar 

información digital, así como realizar gráficos y mapas, y representar datos alfanuméricos. 

De acuerdo a Burrough (1994) un SIG también puede verse como un modelo informatizado 

de la realidad geográfica para satisfacer unas necesidades de información concretas, esto es, 

crear, compartir y aplicar información útil basada en datos y en mapas. 

Durante décadas los SIG se han aplicado a problemas de gestión territorial y de recursos 

naturales, a cuestiones relacionadas con el medioambiente, la logística militar o en contextos 

directamente vinculados con las ciencias de la Tierra, como la geografía, la geología, etc. 

Además, recientemente se ha empezado a considerar el uso potencial de los SIG para otros 

campos y disciplinas relativamente inéditos y en particular en la investigación en Ciencias 

Humanas y Sociales (Del Bosque González et al. 2012). 

ArcGIS Desktop (En adelante ArcGIS) es el principal componente de la suite de aplicaciones 

ArcGIS de ESRI, y el software que contiene las funcionalidades clásicas del SIG de escritorio. 

ArcGIS es un conjunto de herramientas que permiten la visualización y manejo de 

información geográfica, y que cuenta con una arquitectura extensible mediante la que pueden 

añadírsele nuevas funcionalidades (Olaya, 2011) . Estas son las conocidas extensiones, entre 

las cuales se pueden destacar Spatial Analyst (análisis ráster), 3D Analyst (análisis 3D y de 

relieve) o Geostatistical Analyst (geoestadística). 
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1. CARTOGRAFÍA 

La cartografía es la ciencia que estudia los mapas y desde su inicio ha sido objeto de interés 

para distintos ámbitos como el desarrollo económico, la estrategia militar o la gestión de 

recursos. Pero lo que venimos a tratar hoy es la cartografía histórica, también una ciencia, 

enfocada en los acontecimientos humanos a través de su representación en el campo de 

operaciones donde ocurrieron, o su plasmación en esquemas comprensibles, caso de los 

mapas, retratos literarios, pinturas o esquemas, que empleando imágenes o signos reseñan 

una realidad sucedida. 

Pero también como disciplina científica actual que se ocupa de la reconstrucción de los 

hechos históricos a partir de la cartografía. De este modo, tanto las cartas de navegación 

como los mapas, no son solo simples elementos de adorno o apoyo documental, sino que 

son la historia en sí. Siempre ha sido evidente la especulación relativa a las dimensiones, 

la forma y la composición de la tierra. Por tal razón, se debe reconocer a la Cartografía, 

como una ciencia que está en proceso de desarrollo técnico, pues cada día sus retos son 

más rigurosos y buscan entregar al usuario final datos geográficos con calidad y eficiencia. 

Con el paso de los siglos y los distintos cambios de perspectiva global, la cartografía 

histórica siguió siendo utilizada en mayor o menor medida como la disciplina auxiliar más 

interesante de la historia. 

      Imagen 1: Cartografía 

 

Fuente: http://cartografiadelentornogeografico.blogspot.com/2016/04/la-cartografia-

es-la-encargada-de.html 

Elaborado por: Cartografía del entorno geográfico. 

 

 

 

                             Términos geográficos 
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La información geográfica en formatos digitales requiere una homologación de criterios e 

incorporación de parámetros mínimos que garanticen su calidad y que además permitan 

la interoperabilidad entre los usuarios para optimizar su utilización e intercambio, y lograr 

un reúso y democratización de la información (SENPLADES, 2013). 

A continuación, se detalla un glosario de los términos geográficos más relevantes que 

serán utilizados en el presente documento. Algunos términos provienen de la serie técnica 

Estándares de  Información Geográfica publicado  por  SENPLADES (2013)  en  su  

sección Terminología  para  Información  Geográfica,  los  cuales  se  basan  en  la  Norma  

ISO/TS 19104:2008 Geographic information - Terminology e ISO/TC 211 Multi-Lingual 

Glossary of Terms. Tenga en cuenta que los términos seguidos de las letras numeradas 

“A” o “B” hacen referencia a los Anexos de esta serie técnica. 

Banda. – Cada una de las partes en las que se divide el espectro electromagnético a efectos 

de captar la radiación por los sensores. Los datos de radiación (valores numéricos) 

captados para cada banda definida se suelen organizar como archivos ráster (Moreno 

Jiménez, 2008). 

Capa. - Unidad básica de la información geográfica que puede ser solicitada en forma de 

mapa desde un servidor [ISO 19128:2005]. Conceptualmente, una capa es una porción o  

estrato  del  espacio  geográfico  en  un  área  en  particular.  Podría  considerarse 

equivalente a un elemento de la leyenda del mapa (SENPLADES, 2013). 

Coordenada. - Valor medido sobre la superficie terrestre que sirve para determinar sobre 

ella la posición de cualquier punto y, en consecuencia, la que tiene respecto a cualquier 

otro lugar. Para determinar esos valores se utilizan líneas imaginarias, perpendiculares 

entre sí, denominadas paralelos y meridianos, cuya intersección define la posición del 

punto en el sistema de coordenadas (López Trigal, 2015). 

Datum. - Parámetro o conjunto de parámetros que definen la posición (A.282) del origen, 

la escala y la orientación de un sistema de coordenadas [ISO 19111:2007]. 

Datum vertical. - Datum que describe la relación de la altura relacionada con la gravedad 

o profundidad con la Tierra. NOTA: En la mayoría de los casos, al datum vertical se lo 

relaciona con el nivel medio del mar. Las alturas geodésicas se tratan en relación a un 

https://doi.org/10.33262/cde.3
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sistema de coordenadas elipsoidales tridimensional que hacen referencia a un datum 

geodésico [ISO 19111:2007]. 

Elipsoide. -  Superficie formada por la rotación de una elipse alrededor de un eje principal. 

NOTA: En esta norma internacional, los elipsoides son siempre oblongos, lo que significa 

que el eje de rotación es siempre el eje menor [ISO 19111:2007]. 

Escala. – Relación que existe entre las magnitudes de los elementos representados en el 

mapa y las que estos mismos tienen en la realidad. Define la reducción a la que debemos 

someter a la superficie terrestre para poder representarla en un documento, en un mapa, 

cuyo tamaño es mucho menor. La representación de la escala en un mapa puede ser gráfica 

o numérica (López Trigal, 2015). 

Geoposicionamiento. - Recuperación de la posición geográfica de un objeto [ISO/TS 

19130:2010]. 

Georeferenciación. – Operación de obtener y asignar coordenadas geográficas a una 

información (normalmente una capa) que carece de ella. Suele aplicarse para situar 

imágenes de la Tierra o eventos asociados a direcciones postales (Moreno Jiménez, 2008). 

Imagen. - Cobertura tipo ráster cuyos valores de atributo son una representación numérica 

de un parámetro físico [ISO 19115-2:2009]. 

Latitud. -  Normalmente representada por el símbolo φ, es el ángulo formado, desde el 

centro de la Tierra sobre el plano de meridiano, por la normal al elipsoide en el punto 

considerado y el plano del ecuador. Todos los puntos de la superficie de la Tierra con igual 

latitud definen las líneas de paralelos. La medida se expresa en notación sexagesimal 

partiendo del Ecuador, positiva hacia el norte (0° a 90°) y negativa en el sur (0° a -90°) 

(Del Bosque González et al. 2012). 

Leyenda. - Aplicación de una clasificación (A.52) en un área específica usando una escala 

de mapeo definida y un conjunto específico de datos [ISO 19144-1:2009]. 

Longitud. - Normalmente representada por el símbolo griego λ, es el ángulo diedro, 

formado desde el centro de la Tierra sobre el plano del ecuador, entre el meridiano que 

contiene el punto y el meridiano tomado como origen. El plano del ecuador es el que pasa 

por el centro de la Tierra y es perpendicular al eje de rotación. Los meridianos son las 

líneas formadas por todos los puntos de igual longitud, y representan la intersección de la 
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superficie de la Tierra con planos perpendiculares al plano del ecuador y que contienen el 

eje de rotación (Del Bosque González et al. 2012). 

Modelo digital del terreno y modelo digital de elevaciones. -  Un modelo digital del 

terreno es una representación espacial de una variable cuantitativa y continua, como puede 

ser la temperatura, la cota o la presión atmosférica. En particular, cuando la variable a 

representar es la cota o altura del terreno se denomina Modelo Digital de Elevaciones o 

MDE. Por tanto, un modelo digital de elevaciones es una estructura numérica de datos que 

representa la distribución espacial de la altitud de la superficie del terreno (Mancebo at al. 

2008). 

Pendiente. - Relación de cambio de elevación con respecto a la longitud de la curva [ISO 

19133:2005]. 

Proyección cartográfica. - Operación geométrica que permite representar la superficie 

curva de la tierra (tridimensional) en una superficie plana (bidimensional). Procedimiento 

que se utiliza para transformar las coordenadas angulares con las que se determina la 

localización de los objetos geográficos sobre el globo terrestre en coordenadas planas que 

permiten la representación cartográfica en una superficie de dos dimensiones (López 

Trigal, 2015). 

Teledetección o Percepción Remota. - En un sentido amplio se puede definir como la 

adquisición de información sobre un objeto a distancia, esto es, sin que exista contacto 

material entre el objeto o sistema observado y el observador (Sobrino, 2000). 

1.1 Finalidades de la cartografía   

Desde sus orígenes, las imágenes de los mapas mantienen dos características esenciales:  

1. Los elementos representados se sitúan en posiciones relativas similares a las que 

tienen en la realidad.  

2. Los elementos deben representarse con distintos símbolos que indiquen la clase 

de objeto a la que pertenecen.  

1.2 Definición de cartografía 

La Cartografía es el arte y la ciencia de representar el espacio real o imaginado, en 

diferentes tipos de dibujos o representaciones digitales. Para ello utiliza una seria de 

técnicas destinadas a la correcta presentación del espacio y sus atributos.   
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Como un sistema de comunicación:  

• Integra diferente información  

• Permite análisis de variables  

• Se aplica a múltiples disciplinas  

 Por lo general el resultado es una representación gráfica de una situación.  

Posee un método de trabajo:   

• Recogida y selección de datos  

• Manipulación y generalización de los datos  

• Lectura y observación de mapas  

• Respuesta e interpretación de los datos a partir del mapa 

Imagen 2: Representación gráfica de Cartografía 

 

  Fuente: Slide Player 

  Elaborado por: Cristina Bustos 

 

 

 

 

 

 

1.3 Errores en la cartografía  

 

Tabla 1  

1. Toma de decisiones  a. Datos incompletos  
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 b. Uso de conceptos equivocados  

2. Editor-Autor  a. Mala elección de datos  

b. Definir incorrectamente los propósitos del mapa. 

c. Incluir excesiva o muy poca información  

3. Diseñador Cartográfico  a. Variables visuales mal seleccionados  

b. Diseño erróneo de la simbología  

4. Dibujante Cartográfico  a. Calidad pobre del dibujo  

b. Colocación de textos incorrectos  

5. Usuario del mapa  a. Incapaz de detectar la información relevante 

b. Nivel cultural y de conocimientos inadecuados  

c. Errónea interpretación de la información  

 

2. CARTOGRAFÍA BÁSICA 

Es la cartografía más importante y más necesaria a partir de la cual pueden obtenerse otros 

mapas derivados de ella. (David J. Cuff. "Thematics Maps")  

Cartografía general 

La cartografía general tiene que ver con todos esos mapas que se elaboran para una 

audiencia general y con diversas referencias. El mapa de un país o un mapamundi, son 

ejemplos de cartografía general. 

2.1 Cartografía Temática 

Conjunto de actividades cartográficas tendentes a mostrar las características estructurales 

de una determinada distribución geográfica.  

Cartografía Temática  

a) Cuantitativa si se muestran distribuciones numéricas de un acontecimiento.  

b) Cualitativa si lo que se muestran son las clases en las que se puede descomponer 

el acontecimiento.  

2.2 Elementos Básicos de un Mapa  

1. Título: Indica el tipo de mapa, además ofrece información sobre el lugar y hace 

referencia al tipo de información que presenta.  

2. Fuentes: notas de reconocimiento y fechas de producción de los datos.  

3. Leyenda: describe la forma en que los valores se convirtieron en símbolos 

cartográficos (Líneas, puntos, colores, figuras, etc.).  

https://doi.org/10.33262/cde.3
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4. Escala: Este es el dato más importante de un mapa, nos dice qué relación existe 

entre la realidad y el dibujo. Si tenemos un mapa 1:100,000 quiere decir que 

100,000 unidades reales del terreno están representadas en el mapa como una 

unidad.  

2.3 Elementos Básicos de un Mapa  

L a escala se puede representar de dos formas:  

Escala numérica: Se representa con números, 1: 10,000 1/10,000 y se lee uno en diez 

mil.  

Escala gráfica: Es una pequeña regla que indica la escala usada y sirve para medir las 

distancias dentro del mapa  

Orientación: es importante indicar en un mapa donde está el norte, la mayoría de los 

mapas están orientados con el norte hacia arriba en la página. La orientación se indica con 

un símbolo: una flecha o una rosa de los vientos que apunta hacia el norte.  

Curvas de nivel: es aquella línea trazada sobre el mapa que representa otra línea 

imaginaria en la superficie de la tierra a una elevación constante, más alta o más baja 

sobre el nivel del mar. Es un elemento muy importante en la cartografía básica (Hojas 

cartográficas).  

La Forma de la Tierra:  

Geoide: Superficie definida por los mares en reposo prolongada por debajo de los 

continentes.  

Elipsoide: Forma matemática más semejante al geoide.  

Datum: Vértice en el que se hace coincidir.  

Geoide y elipsoide. En éste coordenadas astronómicas y geodésicas coinciden.  

Superficie con fuerza gravitatoria constante, aproximada a la figura de la Tierra, a 

diferencia del elipsoide ondula en respuesta a las fuerzas gravitatorias.  

Figura matemática tridimensional formada al rotar una elipse alrededor de su eje menor  
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La forma de la Tierra es casi redonda, pero no tiene una figura geométrica clara.  

2.4 La forma de la tierra latitud 

Puede decirse que, en este sentido, la latitud es el trayecto angular que separa al Ecuador 

de cualquier punto terrestre. Dicha medición se lleva a cabo teniendo en cuenta el 

meridiano al que corresponde el punto angular. Cabe recordar que los meridianos son los 

círculos máximos de la esfera de la Tierra que atraviesan los polos, individualizados como 

líneas imaginarias que permiten establecer el horario. 

Los paralelos se enumeran de 10 en 10 grados sexagesimales. El punto designado con la 

letra P, en la figura, entonces tendría una latitud de 40° norte. Todas las latitudes medidas 

desde el plano del Ecuador hacia el polo norte por convención se consideran positivas. 

  Imagen 3: Latitud 

 

  Fuente: SlideShare 

  Elaborado por: Cristina Bustos 

 

Longitud 

Es el ángulo que se mide entre el meridiano del punto que se requiere saber su longitud y 

el meridiano de Greenwich, utilizando la línea del Ecuador. Se mide en unidades angulares 

(ángulos sexagesimales). El círculo se divide en 360°, cada grado sexagesimal se mide en 

60 minutos sexagesimales y cada minuto sexagesimal, a su vez, se divide en 60 segundos 

sexagesimales. El grado sexagesimal se simboliza con: °, el minuto se simboliza con ´ y 

el segundo con ´ 

    Imagen 4: Longitud 
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   Fuente: SlideShare 

   Elaborado por: Cristina Bustos 

 

3. PROYECCIÓN CARTOGRÁFICA 

Correspondencia entre los puntos del elipsoide (superficie terrestre) y su transformación 

en un plano.  

Mapas de continentes o de propósito general. 

Representaciones de Europa, Australia y países no excesivamente 

desproporcionados 

Cónica 

África y Sud-América Sanson- 

Flamstead 

Zonas con gran extensión de E-W y tierras situadas en las zonas 

tropicales 

Mollweide 

Zonas Polares Azimutales 

3.1 Coordenadas Geográficas  

Son las coordenadas esféricas que indican localización sobre el elipsoide terrestre. Puesto 

que cualquier punto de la esfera está definido por sus coordenadas geográficas (l,f) y 

cualquier punto del plano lo está por sus coordenadas cartesianas (X,Y), existirá una serie 

infinita de relaciones que liguen (l,f) con (X.Y). Cada una de estas infinitas relaciones 

será un Sistema de Proyección Cartográfico.  

3.2 Proyecciones Geográficas  

Mencionaremos algunas proyecciones geográficas  
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• Proyección Polar Estereográfica  

• Proyección Lambert de Azimut y Áreas Constante  

• Proyección de Azimut Equidistante  

• Proyección Ortográfica  

• Proyección Mercator  

Esta proyección cilíndrica es realmente un escalado lineal de longitudes y latitudes, Es 

también conocida como la Proyección de Platee Caree.   

Todas las líneas de los meridianos y paralelos son líneas rectas, y todas las áreas 

representadas corresponden a perfectos cuadrados. Se puede observar que las áreas en la 

proyección Mercator cerca de los polos son más grandes.  

3.3 Georeferencia  

Ubicación de puntos en referencia a la superficie terrestre, es necesario contar con un 

sistema de referencia que represente a la Tierra y establezca cómo describir las posiciones. 

Para la localización de un punto se pueden utilizar cualquiera de los siguientes 

parámetros:   

• Coordenadas geográficas en formato Longitud – Latitud  

• Coordenadas UTM (Universal Transversa Mercator), coordenadas métricas o 

planas (X, Y)   

• Universal Transversal Mercator  

• La tierra se divide en forma vertical, 60 zonas (husos).  

• Cada zona tiene 20 bandas horizontales:  

• Bandas de la C a M están en el hemisferio sur  

• Bandas N a X están en el hemisferio norte  

• Cada zona o huso abarca 6 grados de longitud.  

• Este sistema utiliza como unidad de medida el metro. 

• Materia descriptiva  

• Ciencia nemotécnica  

• Saber enciclopédico  
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4. LA GEOGRAFÍA 

Es la ciencia que se encarga de la descripción de la Tierra. También la palabra puede 

utilizarse para hacer referencia al territorio o al paisaje. 

La geografía, por lo tanto, estudia el medio ecológico, las sociedades que habitan en él y 

las regiones que se forman al producirse esta relación. En otras palabras, se encarga de 

analizar la relación hombre-Tierra y los fenómenos geográficos de la superficie terrestre. 

Ciencia de las causas, estructuras, funciones y características de los Paisajes  

Estudia: localización, distribución y relación de los fenómenos de la superficie terrestre.  

Evolución de la ciencia geográfica 

La geografía hasta el siglo XX tiene dos fases que son: 

• Precientífica: Subjetiva y descriptiva (mitos…). 

• Científica: leyes y razones lógicas. 

4.1 Fase pre-científica   

Etapa clásica 

Orientaciones: Descriptiva, explorativa, matemática, mediciones. 

Autores: griegos, romanos. 

Edad media 

Mundo árabe: orientación corológica 

Mundo cristiano: orientación cartográfica 

Edad moderna 

Dentro de la edad moderna tenemos: 

 Descubrimientos, exploraciones, expediciones, etc. 

KANT: exclusividad regional, sistematización. 

Enciclopedia: Ciencias naturales, ciencias sociales.   
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4.1.1 Primera Ley de Tobler de Geografía  

Todas las cosas están relacionadas. Sin embargo, todos los demás en igualdad de 

condiciones, las cosas que están más cerca juntas están más relacionadas.   

Conceptos relacionados:  

• Distancia de desintegración   

• Espacio  

Latitud y Longitud: Un sistema de referencia diseñado para proporcionar “absoluta 

ubicación” (a diferencia de lugares en relación)  

• Los paralelos de latitud  

• Meridianos de Longitud   

4.1.2 Lugar y Sentido de Lugar   

Cada lugar es único. Imagínese cuando usted vivió como un niño. ¿Qué hizo que sea 

especial?    

• Sensorial  

• Arquitectura  

• Simbólico  

Geografía humanista: Los valores de la perspectiva individual.   

Componentes de un SIG  

Personas: El más importante componente de un SIG, desarrollo de procedimientos y 

definición de tareas.  

Datos disponibles y precisos: Afectan los resultados de cualquier consulta o análisis  

Hardware: afectan la velocidad de procesos, facilidad de uso, y el tipo de resultados 

disponibles.  

Software: nos solo es el SIG, también lo componen bases de datos, estadísticos, imágenes 

y paquetes de aplicación específica.  
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Procedimientos: Órdenes para obtener respuestas correctas, una serie de pasos que deben 

ser seguidos.  

Funciones de un SIG  

• Captura de datos  

• Manipulación de datos y análisis  

• Creación de despliegues y copias en papel   

• (mapas y reportes)  

¿Qué puedes hacer con un SIG?  

Puedes resolver problemas del mundo real con un SIG. Usando varias fuentes, análisis y 

técnicas de salidas.  

Puedes manipular tanto datos geográficos como tabulares.  

Las fuentes de información pueden ser:  

• Digitalizando un mapa o registrando una imagen  

• Convirtiendo un archivo en formato ASCII  

• Convirtiendo datos digitales desde otros formatos.  

• Introduciendo datos recopilados desde el teclado o leyéndolos desde un archivo.  

4.2 La representación de los datos  

Los datos SIG representan los objetos del mundo real (carreteras, el uso del suelo, 

altitudes). Los objetos del mundo real se pueden dividir en dos abstracciones: objetos 

discretos (una casa) y continuos (cantidad de lluvia caída, una elevación). Existen dos 

formas de almacenar los datos en un SIG: raster y vectorial. 

Los SIG RASTER son muy utilizados en estudios que requieran la generación de capas 

continuas, necesarias en fenómenos no discretos; también en estudios medioambientales 

donde no se requiere una excesiva precisión espacial (contaminación atmosférica, 

distribución de temperaturas, localización de especies marinas, análisis geológicos, etc.). 

Los SIG EN FORMATO VECTORIAL son los más populares en el mercado.   
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En los datos vectoriales, el interés de las representaciones se centra en la precisión de 

localización de los elementos geográficos sobre el espacio y donde los fenómenos a 

representar son discretos.  

Por ejemplo, una base de datos que describe los lagos puede contener datos sobre la 

batimetría de estos, la calidad del agua o el nivel de contaminación  

4.3 Modelos de datos espaciales  

Un modelo de datos geográficos es una representación del mundo real que puede ser usado 

en un SIG para producir mapas, realizar consultas y diferentes análisis.  

Este conjunto de objetos espaciales permite a una aplicación SIG, desplegar mapas, 

realizar consultas, edición y análisis.  

Ejemplo RIOS o Cursos de agua:  

1. Un conjunto de líneas que forman una red. Cada segmento de línea tiene una 

dirección de flujo, volumen, y otros atributos asociados. Se puede entonces 

analizar el flujo hidrológico o tráfico de buques  

4.4 Modelos de datos espaciales  

1. Borde entre dos áreas. Un rio puede delimitar departamentos, u otras divisiones 

políticas, o puede ser barrera de regiones naturales.  

2. Como áreas que representen bancos y canales de navegación.  

3. Líneas que forman accidentes geográficos en un modelo de terreno. Se puede 

calcular el perfil de un río así como su rango de descenso a partir de un modelo 

de terreno. De esta forma también es posible calcular cuánta agua aporta a un lago, 

y su potencial caudal.  

5. MODELO DE DATOS DE GEODATABASE 

Datos “más inteligentes”: comportamiento y relaciones. Brinda un modelo físico de datos 

más representativo (directamente) del modelo lógico.  

 Permite implementar comportamiento asociado a los datos sin escribir código, a través 

de dominios, reglas de validación y otras funciones. Comportamiento más especializado 

o específico debe ser a través de código.  

https://doi.org/10.33262/cde.3


IBSN: 978-9942-8705-3-7 

    Ciencia Digital Editorial  

15 DOI: https://doi.org/10.33262/cde.3  

5.1 Edición de elementos  

• Valores de atributos pertenecen a un dominio.  

• Un elemento puede ubicarse adyacentemente a otro si se cumple determinada 

condición o regla. Ej. Una ruta no puede cortar a un rio si no existe un puente en 

el corte.  

• Ciertos elementos geográficos deben estar organizados como se encuentran en la 

naturaleza. Ej. Sentido en que corre un rio y sus afluentes.  

• La geometría de un elemento debe responder a un patrón determinado. Ej. Las 

líneas y curvas que componen una ruta deben ser tangentes.  

5.1.2 Despliegue de la cartografía  

Interacción de distintos elementos al momento de desplegarse para no entrar en conflicto 

“visual”. Ej. Nombres de calles sobre los ejes de calles, rutas y sus cortes, redes.  

Análisis interactivo  

Implica la selección de uno o más elementos (gráficamente, por atributos, etc) y hacer 

algo con ellos, como ser actualizar propiedades, realizar una consulta espacial y/o de 

atributos.  

Ej.: Seleccionar una parte de una red eléctrica sobre una línea de mantenimiento, encontrar 

todos los consumidores afectados, y mandarles un aviso para notificarles algo.  

5.1.3 Beneficios de una GEODATABASE  

• Repositorio uniforme de datos geográficos  

• El ingreso de datos y la edición es más precisa  

• Los usuarios pueden trabajar con objetos en forma más intuitiva  

• Los elementos geográficos poseen un contexto más rico  

• Pueden hacerse mejores mapas (intelligent drawing behavior)  

• Elementos responden automáticamente a cambios en elementos vecinos.  

Más formas geométricas para definir entidades geográficas.  

• Almacenamiento de grandes cantidades de elementos geográficos en forma 

continua.  
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• Varios usuarios pueden editar el mismo conjunto de datos geográficos en forma 

simultánea.  

• Orientada a objetos: polimorfismo, encapsulamiento, herencia A pesar de que algunos de 

los beneficios que se mencionan se pueden realizar con una simple base de datos 

relacional, solo sería posible mediante la escritura de código complejo.  
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CAPÍTULO II 
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6. NOCIONES BÁSICAS PARA EL MANEJO DEL GPS 

6.1 Posicionamiento global 

6.1.1 Antecedentes 

Desde que en 1957 el lanzamiento del Sputnik 1 supuso el comienzo de la era de los 

satélites artificiales y su posterior uso en aplicaciones para el interés de la comunidad 

mundial. El GPS fue diseñado originalmente para aplicaciones militares y de los servicios 

de inteligencia en plena Guerra Fría durante la década de los 60, aunque se inspiró en el 

lanzamiento de la nave espacial soviética Sputnik en 1957. 

6.1.2 Concepto 

El concepto de Posicionamiento Global se fundamenta en un sistema de posicionamiento 

espacial basado en señales de radio, que suministra durante las 24 horas del día, posición 

tridimensional e información de velocidad y tiempo mediante el uso de equipo apropiado 

en cualquier parte del mundo sobre la superficie de la tierra. 

6.1.3 Características de los sistemas de posicionamiento satelital 

• Preciso 

• Confiable 

• No se requiere intervisibilidad entre puntos 

• Cobertura mundial 

• Capacidad ilimitada de usuarios 

          Imagen 5: Posición satelital 

 

Fuente: SlidePlayer 

Elaborado por: Lidia Ojeda Lagos 
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6.1.4 Sistemas globales de navegación por satélite (GNSS) 

GPS: Sistema de posicionamiento de los Estados Unidos 

GLONASS: Sistema de posicionamiento de Rusia 

GALILEO: Sistema de Posicionamiento de la Comunidad Europea 

BEIDOU: Sistema de Posicionamiento de la República Popular China 

6.1.5 Funcionamiento del GPS 

La constelación GPS básica estriba en 24 satélites operacionales. La Fuerza Aérea del 

Espacio de USA (AFSC) declaró formalmente en Abril 27 de 1995 que la constelación 

de satélites GPS cumplió los requerimientos de Capacidad Total Operacional  (FOC), 

correspondiente a 24 satélites operacionales de los Bloques II y IIA funcionando en sus 

órbitas asignadas, y respondiendo satisfactoriamente a las pruebas de funcionalidad 

operacional militar. 

Imagen 6: Funcionamiento del GPS 

 

Fuente: SlidePlayer 

Elaborado por: Lidia Ojeda Lagos 
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6.1.6 Componentes de un sistema GPS 

 

          Imagen 7: Funcionamiento del GPS 

 

                              Fuente: SlidePlayer 

      Elaborado por: Lidia Ojeda Lagos 

 

Segmento espacial 

• 24 Satélites 

• Seis (6) orbitas, con una inclinación de 55°  

• Cuatro (4) satélites en cada orbita. 

• Orbita de 20,200 km. 

• revolución en 12 horas 

• Frecuencias de transmisión:  

• L1=1575,42 MHz  

• L2=1227,60 MHz  

• Datum de referencia: WGS-84 

• Mejoras: Código L2C (Señal redundante) y Frecuencia L5 (Mas alta potencia de 

transmisión), L1M – L2M (militares) 

Segmento de control 

• Estación maestra de control 

• 10 Estaciones en todo el mundo 

• Todas desarrollan funciones de Monitoreo 

• Reciben las señales de los satélites 

• Capturan Datos Meteorológicos 
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• Transmiten Datos a Estación Maestra de Control 

Segmento de usuario 

• Un receptor GPS es un receptor de radio especializado.  

• Es diseñado para captar las señales de radio que son transmitidas desde los 

satélites, y calcula una posición basado en la información recibida.  

• Los receptores son de diferentes tamaños, formas, aplicaciones, características y 

precios. 

7. TIPOS DE RECEPTORES GPS 

Los receptores GPS detectan, decodifican y procesan las señales que reciben de los 

satélites para determinar el punto donde se encuentran situados y son de dos tipos: 

portátiles y fijos. Los portátiles pueden ser tan pequeños como algunos teléfonos celulares 

o móviles. Los fijos son los que se instalan en automóviles o coches, embarcaciones, 

aviones, trenes, submarinos o cualquier otro tipo de vehículo. 

Receptor Código Fase portadora Equipamiento 

Geodésico P L1 y L2 Base + móvil 

Topográfico C/A y P L Base + móvil 

Navegador C/A L1 Móvil 

 

7.1 Navegadores 

Estos GPS son más para fines recreativos y aplicaciones que no requieren gran precisión 

(cartografía a escalas 1:25.000 y menores). La integración de sistemas de navegación en 

los Smartphone marcó el principio del fin de la época dorada de los navegadores GPS. 

Utilizan el código C/A + fase portadora L1. 
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     Imagen 7: Navegadores 

 

7.2 Características básicas que debe tener un navegador GPS para cartografía 

• 12 canales paralelos: necesario para poder tener una buena recepción de las 

señales en terrenos abruptos y con espesa cobertura vegetal.  

• Waypoints (puntos de referencia) 

• Pantalla de Mapa: para poder ver más fácilmente nuestra posición con respecto a 

los demás waypoints marcados.  

• Track: corresponden a las huellas de nuestro trayecto realizado, para así poder 

repetirlas o hacerlas de vuelta en caso de que no reconozcamos el camino.  

• Múltiples Datum: para poder ocupar el GPS con las cartas topográficas del propio 

país.  

• Cartografía digital incluida en el propio receptor: útil para ver plasmado sobre un 

mapa, donde nos encontramos. 

7.3 Campos de aplicación de los GPS 

Gráfico 1: Aplicación de los GPS 

Fuente:      Fuente:Propia 

Elaborado por: Klever Espinosa 

GPS
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8. COMPONENTES DEL SIG Y REPRESENTACIÓN 

8.1 Componentes 

• Personas: El más importante componente de un SIG, desarrollo de procedimientos 

y definición de tareas. 

• Datos disponibles y precisos: afectan los resultados de cualquier consulta o 

análisis. 

• Hardware: afectan la velocidad de procesos, facilidad de uso, y el tipo de 

resultados disponibles. 

• Software: nos solo es el SIG, también lo componen bases de datos, estadísticos, 

imágenes y paquetes de aplicación específica. 

Funciones del SIG 

• Captura de datos 

• Manipulación de datos y análisis 

• Creación de despliegues y copias en papel (mapas y reportes) 

¿Qué puedes hacer con un SIG? 

Puedes resolver problemas del mundo real con un SIG. Usando varias fuentes, análisis y 

técnicas de salidas.  

• Puedes manipular tanto datos geográficos como tabulares. 

• Las fuentes de información pueden ser: 

• Digitalizando un mapa o registrando una imagen 

• Convirtiendo un archivo en formato ASCII 

• Convirtiendo datos digitales desde otros formatos. 

• Introduciendo datos recopilados desde el teclado o leyéndolos desde un archivo 

8.2 La representación de los datos 

Los datos SIG representan los objetos del mundo real (carreteras, el uso del suelo, 

altitudes). Los objetos del mundo real se pueden dividir en dos abstracciones: objetos 

discretos (una casa) y continuos (cantidad de lluvia caída, una elevación). Existen dos 

formas de almacenar los datos en un SIG: raster y vectorial. 
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Los SIG RASTER son muy utilizados en estudios que requieran la generación de capas 

continuas, necesarias en fenómenos no discretos; también en estudios medioambientales 

donde no se requiere una excesiva precisión espacial (contaminación atmosférica, 

distribución de temperaturas, localización de especies marinas, análisis geológicos, etc.). 

   Imagen 8: SIG Raster 

 
  Fuente: Wordpress 

  Elaborado por: Juan Contreras 

 

8.3 Formato vectorial 

Son los más populares en el mercado. En los datos vectoriales, el interés de las 

representaciones se centra en la precisión de localización de los elementos geográficos 

sobre el espacio y donde los fenómenos a representar son discretos. 

Por ejemplo, una base de datos que describe los lagos puede contener datos sobre la 

batimetría de estos, la calidad del agua o el nivel de contaminación. 

Modelos de datos espaciales 

Un modelo de datos geográficos es una representación del mundo real que puede ser 

usado en un SIG para producir mapas, realizar consultas y diferentes análisis. Este 

conjunto de objetos espaciales permite a una aplicación SIG, desplegar mapas, realizar 

consultas, edición y análisis. 

9.   Herramientas de geoprocesamiento 

Sin duda, las herramientas SIG automatizan los procesos que antes tomaban mucho 

tiempo en ser desarrollados. En general las tareas manuales suelen requerir un gran 

esfuerzo para completarse. El geoprocesamiento es la ejecución metódica de una secuencia 

de operaciones en los datos geográficos para crear nueva información. Los dos propósitos 
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fundamentales que persiguen estas herramientas son ayudar a realizar el modelamiento 

y el análisis, y automatizar las tareas SIG (ESRI, 2016b). 

A partir de ahora se usarán con mayor frecuencia las herramientas desde ArcToolbox   (

), aunque algunas de las herramientas más comunes de geoprocesamiento se pueden 

acceder desde el menú Geoprocessing. El uso de cada herramienta presenta una estructura 

similar: una ventana emergente solicita archivos de entrada y salida, aparte de campos 

configurables dependiendo de la naturaleza de la herramienta. 

9.1.    Áreas de influencia (Buffer) 

Imaginemos por un instante que una gota de agua cae sobre una masa de agua y genera 

una onda expansiva. La onda se traslada y el fenómeno de propagación puede causar 

modificaciones de forma positiva o negativa desde su origen. Las zonas de influencia son 

polígonos creados a partir de una entidad a una distancia establecida. Este análisis espacial 

permite conocer la superficie afectada (p.ej. establecimiento de una fábrica), las zonas de 

influencia (p.ej. apertura de una vía dentro de un área protegida), la afectación por un 

contaminante (p.ej. fertilizantes), y el alcance de antenas (p.ej. telecomunicaciones o 

radares meteorológicos). 

Con  la  herramienta Buffer  se  pueden  crear  zonas  de  influencia para  puntos,  líneas  

y polígonos. La herramienta se encuentra disponible en la barra de menús Geoprocessing 

o en la siguiente dirección: 

ArcToolbox > Analysis Tools > Proximity > Buffer 

La  configuración principal de la ventana emergente “Buffer” (Imagen 9) se puede 

realizar de la siguiente manera: 

 

 

 

 

 

                              Imagen 9: Configuración herramienta Buffer 
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-  Input Features.- Selecciona la capa de puntos, líneas o polígonos. 

-  Output Features Class.- Selecciona el directorio o geodatabase donde se almacenará la 

entidad resultante. 

-  Distance [value or field].- Presenta dos opciones: “Linear unit”, que permite establecer 

un valor fijo con su respectiva unidad (p.ej. metros), y “Field”, que crea una zona de 

influencia en base a los valores de un campo seleccionado de la tabla de atributos. 

Method.- Específica el método a usar para crear la zona de influencia. El método “Planar” 

usa la distancia euclidiana (cómo si se midiese con una regla en un plano proyectado), y 

“Geodesic” toma en cuenta la curvatura de la tierra independientemente del sistema de 

coordenadas de la capa. Las zonas de influencia no están influenciadas por la distorsión 

de un sistema de coordenadas proyectadas. 

En la imagen 9 muestra un resultado de zonas de influencia para tres puntos, una línea 

y dos polígonos usando como distancia una unidad linear de 20 meteros y el método 

planar. 

 

Imagen 10: Zonas de influencia 
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9.2.    Intersecciones (Intersect) 

La intersección permite buscar el área de dos o más capas que se superponen. La 

herramienta Intersect calcula el área de intersección en una nueva capa. Para ejecutar la 

herramienta se debe dirigir a: 

ArcToolbox > Analysis Tools > Overlay > Intersect 

Se abre la ventana emergente de Intersect.  En la sección Input Features se pueden 

añadir todas las capas en las que se requiere buscar áreas de intersección. Un ejemplo del 

resultado se puede observar en la Imagen 11. 

Imagen 11: Área de intersección  

 

9.3.    Recortes (Clip) 

La herramienta Clip permite recortar parte de una entidad en base al perímetro de una capa 

poligonal (Imagen 12). La capa poligonal se usa para limitar la extensión de las capas a un 

área específica. Por ejemplo, si cuenta con una capa de curvas de nivel de un país, se puede 

hacer un recorte para trabajar a nivel de provincia. La herramienta se encuentra en la 

siguiente dirección: 

https://doi.org/10.33262/cde.3


IBSN: 978-9942-8705-3-7 

    Ciencia Digital Editorial  

29 DOI: https://doi.org/10.33262/cde.3  

ArcToolbox > Analysis Tools > Extract > Clip 

Imagen 12: Configuración para realizar clip  

 

 

 

 

 

Para configurar la herramienta se debe realizar el siguiente proceso: 

Input Features.- Selecciona la capa de puntos, líneas o polígonos que se va a recortar. 

Clip Features.- Selecciona la capa poligonal que contiene el perímetro de recorte. 

Output Features Class.- Selecciona el directorio o geodatabase donde se guardará la 

nueva capa recortada. 

XY Tolerance.- Es un parámetro opcional de tolerancia que establece la distancia que se 

puede mover una coordenada tanto en X como en Y. 

Imagen 13: Recorte de entidades vectoriales 

 

9.4.    Fusionar (Merge) 

Para fusionar dos o más entidades en una sola capa se puede emplear la herramienta 

Merge. Todas las entidades a fusionar deben ser del mismo tipo (puntos, líneas o 

polígonos). Se debe tener precaución porque esta herramienta no modifica la geometría de 

las entidades, incluso si existe solapamiento. La herramienta se encuentra en la siguiente 

dirección: 

ArcToolbox > Data Management Tools > General > Merge 

En la ventana emergente de Merge se encuentra la sección Input Dataset donde se 
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seleccionan todas las capas a fusionar (se debe recordar que tienen que ser de la misma 

geometría). En la sección Output Dataset se asigna un nombre y un directorio a la capa 

resultante. En la sección Field Map se añaden, renombran o eliminan los campos de las 

capas participantes. Un ejemplo se indica en la Imagen 14, donde en la parte izquierda se 

encuentran dos capas de polígonos separados y en la parte derecha se muestra la fusión de 

ambas capas en una sola. 

Imagen 14: Fusión de entidades 

 

9.5.    Disolver (Dissolve) 

Esta herramienta unifica la información geográfica en base a un atributo, es decir realiza 

una fusión contigua de la información que comparte un valor idéntico dentro de la tabla 

de atributos. En la Imagen 15 se puede ver que se fusionan todos los polígonos que contienen 

un atributo común. Por ejemplo, esta herramienta se usa cuando a partir de una capa de 

cantones se requiere obtener una capa de provincias. Aunque en este caso la tabla asociada 

a los cantones debe tener un campo que indique la provincia a la que pertenece cada cantón. 

Para abrir la herramienta Dissolve dirigirse a: 

ArcToolbox > Data Management Tools > Generalization > Dissolve 

En la ventana emergente de la herramienta Dissolve se deben configurar los parámetros 

de la siguiente manera: 

Input Features.- Selecciona la capa de puntos, líneas o polígonos sobre la que se va a 

trabajar. 

Output Features Class.-  Selecciona el  directorio o  geodatabase donde se  va  a 

almacenar el archivo resultante. 

Dissolve Field.-  Selecciona el campo que contiene los atributos en función de los 

cuales se fusionarán las entidades. 

Statistics Field.- Permite obtener cálculos estadísticos de los campos a disolver. 
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Imagen 15: Disolver entidades 

 

10. Análisis espacial 

El análisis espacial es el proceso de modelar y obtener resultados mediante el 

procesamiento informático y luego examinar e interpretar los resultados del modelo. El 

análisis espacial resulta  útil  para  evaluar la  idoneidad y  la  capacidad, para  calcular  

y  predecir, y  para interpretar y comprender los fenómenos espaciales (ESRI, 2016b). 

Se requiere una licencia de la extensión Spatial Analyst para poder ejecutar las 

herramientas que se emplearán en este apartado. 

10.1.  Interpolaciones 

La primera ley de la geografía de Tobler (1970) establece: Todos los lugares están 

relacionados, pero los lugares cercanos están más relacionados que los lugares lejanos. 

Por ejemplo, si llueve a un lado de una calle es altamente probable que también llueva 

al otro lado de la calle. 

De acuerdo a Gruver & Dutton (2014) la interpolación es un proceso que utiliza 

mediciones realizadas sobre algún fenómeno (precipitación, temperatura, elevación) en 

determinados lugares (muestras o estaciones) para hacer una predicción sobre este 

fenómeno en lugares donde no se han realizado mediciones. 

Existen muchos métodos de interpolación, de los cuales algunos cuentan con más 

presencia en los SIG por estar más adaptados al tipo de dato que se maneja. Su aplicación 

habitual dentro de un SIG es bidimensional, ya que una capa ráster es una entidad de 

este tipo. Hablamos, por ello, de interpolación espacial. No  obstante, estos métodos 

no  solo se restringen al plano, sino pueden extenderse a un número superior de 

dimensiones para reflejar otras variables tales como la profundidad (por ejemplo, para 

construir un modelo tridimensional de las características del suelo entre dos 

profundidades establecidas y con un intervalo dado), o también el tiempo (Olaya, Sistemas 
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de Información Geográfica, 2014). 

Las técnicas de interpolación mencionadas por (Childs, 2004) son: determinísticas y 

geoestadísticas. La técnica de interpolación determinística crea superficies basadas sobre 

puntos medidos o funciones matemáticas. Métodos como la Distancia Inversa Ponderada 

(IDW = Inverse Distance Weighting) son basados en el grado de similitud de las celdas, 

mientras que métodos como Trend adapta a una superficie lisa determinada por una 

función matemática. La técnica de interpolación geoestadística, como Kriging, se basa en 

estadísticas y son usadas para la predicción más avanzada de modelamiento de superficies, 

que también incluye cierto grado de certeza o exactitud de las predicciones. Existen 

distintas clasificaciones de los métodos de interpolación, algunas de las cuales se pueden 

consultar en (Olaya, Sistemas de Información Geográfica, 2014). 

Sin entrar a más detalles sobre los distintos métodos de interpolación, todos estos se 

encuentran disponibles en  la  siguiente dirección:  ArcToolbox >  Spatial Analyst 

Tools > Interpolation. 

La  Tabla  2  contiene  datos  de  precipitación de  estaciones meteorológicas ubicadas  

en diferentes puntos. La idea central es construir una superficie ráster con valores 

estimados de la precipitación para lugares donde no existen estaciones meteorológicas. 

Tabla 2. Datos de precipitación y temperatura mensual de una red de 

estaciones meteorológicas 

Estación UTM_X UTM_Y UTM_Z Precipitación 

(mm) 

Temperatura 

(°C) A 694294 9558872 2377 89.4 13.13 

B 697901 9563240 2033 40.2 15.51 

C 700975 9560679 2218 53.1 14.23 

D 694716 9555060 2816 75.9 11.17 

E 692138 9559012 2952 72.8 11.07 

F 706230 9560170 2850 102.4 10.34 

G 699711 9553629 2160 72.5 14.59 

 

Sin embargo, para interpolar los datos es necesario tener un shapefile o una capa vectorial 

de puntos. En caso de no existir la capa de puntos se pueden importar coordenadas XY 

y transformarlas a un shapefile. En ArcGIS se admite diferentes formatos de tablas 

como archivos de Excel 97-2003, texto delimitado por tabulaciones, DBF, y CSV.  
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    Práctica: Agregar coordenadas XY y exportarlas como shapefile 

En una nueva ventana de ArcMap, desde la barra de menús dirigirse a File > Add Data 

> Add XY Data. En la ventana emergente que aparece se debe configurar los campos de 

la siguiente manera: 

Choose a table from the map or browse for another table.- Seleccionar la tabla que 

contiene los datos de precipitación. Información de la Tabla 3 almacenada como un 

archivo XLS (Libro de Excel 97-2003). 

X Field.- Selecciona el campo que contiene los valores de longitud (UTM_X). 

Y Field.- Selecciona el campo que contiene los valores de latitud (UTM_Y). 

Z Field.- Es opcional, pero se puede seleccionar el campo que contiene los valores de 

altitud (UTM_Z). 

Coordinate System of Input Coordinates.- En el botón Edit seleccionar el sistema de 

coordenadas, en este caso Projected Coordinate Systems > UTM > WGS 1984 > 

Southern Hemisphere > WGS 1984 UTM Zone 17S. 

Este proceso genera una capa de eventos, sin embargo, para tener esta capa almacenada 

en el disco duro en formato shapefile se requiere seguir los siguientes pasos: Se debe 

hacer clic derecho sobre la capa en la tabla de contenidos e ir a Data > Export Data. Allí 

se abre una ventana emergente donde se selecciona la dirección y nombre del archivo a 

guardar. Si no permite guardar el archivo en formato shapefile, se debe verificar que el 

tipo del formato fue seleccionado correctamente (en Save as type). Este paso es necesario 

para tener información almacenada en un shapefile. 

De las varias opciones de interpolación que permite ArcGIS, el método que se va a 

utilizar aquí para interpolar la precipitación es el método Kriging. Este se encuentra 

ubicado en la siguiente dirección: 

ArcToolbox > Spatial Analyst Tools > Interpolation > Kriging 

La velocidad de ejecución del proceso depende de la cantidad de puntos a procesar y los 

recursos disponibles del sistema. La  ventana emergente de configuración en todas 

las herramientas de interpolación presenta un aspecto similar. Un ejemplo de los 

parámetros que requiere la herramienta, en este caso Kriging (Imagen 16) se describen a 
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continuación: 

Input point features.- Selecciona la capa de puntos que contiene los valores de 

precipitación (p.ej. shapefile creado a partir de la Tabla 2). 

Z value field.- Selecciona el campo que almacena los valores de precipitación. 

Output surface raster.- Selecciona un directorio o geodatabase para almacenar el 

archivo ráster de salida. 

Semivariogram properties.- Permite seleccionar el  método de  interpolación de 

Kriging con su respectivo semivariograma. 

Output cell size.- Establece el tamaño de celda (resolución del mapa resultante). 

Search radius.- Establece los puntos de entrada para interpolar cada celda. 

Output variance of prediction raster. - Es un ráster opcional que contiene los valores de 

semivarianza. 

Imagen 16: Configuración de parámetros de la herramienta Kriging 

 

La Imagen 17 indica los resultados de la interpolación en una superficie ráster con 

valores estimados. En la parte izquierda se pueden ver los puntos donde están 

ubicadas las estaciones meteorológicas (convertido al formato shapefile). En el lado 

derecho se puede ver el mapa resultante de la interpolación como imagen ráster, 
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incluyendo los valores estimados de precipitación para cada celda. El mismo 

proceso se puede repetir para obtener una imagen ráster de temperatura usando 

los valores de la Tabla 2. 

Imagen 16: Interpolación de precipitaciones.  Puntos de las estaciones 

meteorológicas (izquierda) y superficie de predicción interpolada (derecha).  

 

10.2.  Modelos digitales de elevación 

Un Modelo Digital de Elevación (DEM = Digital Elevation Model) es una representación 

en formato ráster de una superficie continua. Por lo general hace referencia a la superficie 

de la tierra, mediante un conjunto de puntos cuyos valores en X, Y y Z son conocidos y 

están definidos en un sistema de coordenadas arbitrario (Fallas, 2007). 

La  información que se  puede derivar a  partir de  modelos digitales de  elevación 

tiene aplicabilidad en diferentes campos, como la hidrología, análisis de riesgos, la 

planificación urbana, entre otros. Los principales productos que se pueden obtener de un 

DEM son: mapas de pendientes, curvas de nivel, mapa de relieve, mapa de visibilidad, 

mapa de aspecto, cuencas hidrográficas, cuencas visuales, etc. 

Imagen 17: Modelo digital de Elevaciones 

 

10.3.  Creación de mapas de pendientes 

La pendiente es el factor principal que determina y diferencia las formas del relieve. 

Dados dos puntos de diferente altitud entre sí, se entiende como pendiente del terreno a 
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la razón matemática determinada por la relación proporcional que existe entre la 

diferencia de altitud y la distancia horizontal entre ambos puntos (Hernández, 1998). 

La pendiente se puede expresar en porcentaje o grados sexagesimales. Para crear un ráster 

de pendiente se requiere de un DEM como información de entrada, y la herramienta 

Slope para generar el ráster de pendiente, la cual está ubicada en: 

ArcToolbox > Spatial Analyst Tools > Surface > Slope 

Imagen 18: Configuración de parámetros de la herramienta Slope 

 

La configuración de la herramienta Slope (Imagen 18) se describe a continuación: 

Input raster.- Selecciona la capa que contiene un DEM. 

Output raster.- Selecciona un directorio o geodatabase para almacenar el archivo ráster 

de pendientes. 

Output    measurement.-    Selecciona    “DEGREE”    para    grados    decimales,    y 

“PERCENT_RISE” para porcentaje. 

Z factor.- Es un factor opcional, se usa para que las unidades lineales Z coincidan con las 

unidades lineales XY. 

 

 

 

Imagen 19: Ráster de pendientes en grados 
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10.4.  Reclasificaciones 

La herramienta Reclassify permite reclasificar los valores de un ráster, es decir reemplaza 

los valores actuales de cada celda, por nueva información. Se pueden reclasificar datos 

de cualquier variable almacenada en formato ráster (pendiente, elevación, precipitación, 

temperatura, etc.). 

Práctica: Construir un mapa de pendiente basado en la clasificación propuesta por la 

FAO (2009) se debe reagrupar en clases los valores del ráster de pendientes (p.ej. Imagen 

20). La Tabla 3 presenta ocho clases, cada una de las clases contiene los valores de 

pendiente en porcentaje y grados decimales. 

Tabla 3. Clases de gradiente de la pendiente 

* La clase 01 es un consolidado de las tres primeras clases de gradiente de (FAO, 2009). 

Para ejecutar la reclasificación abrir la herramienta Reclassify en la siguiente dirección: 

Clase* Descripción Porcentaje Grados 

01 Plano 0 - 1 0 - 0.57 

02 Muy ligeramente inclinado 1 - 2 0.57 - 1.15 

03 Ligeramente inclinado 2 - 5 1.15 - 2.86 

04 Inclinado 5 -10 2.86 - 5.71 

05 Fuertemente inclinado 10 - 15 5.71 - 8.53 

06 Moderadamente escarpado 15 - 30 8.53 - 16.70 

07 Escarpado 30 - 60 16.70 - 30.96 

08 Muy escarpado > 60 > 30.96 
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ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify 

Imagen 20: Configuración de parámetros de la herramienta Reclassify 

 

En la ventana emergente se debe configurar los parámetros que se describen a continuación 

(Imagen 20): 

Input raster.- Selecciona la capa que contiene el ráster de pendientes. 

Reclass field.- Selecciona el campo que contiene los valores de pendiente, por 

defecto suele ser VALUE. 

Reclassification.- Dentro de esta sección al hacer clic en el botón Classify, lo cual abre 

una ventana de clasificación, donde se pueden ajustar los valores de las clases. En la 

sección Classification de ventana de clasificación se puede seleccionar el método de 

clasificación y definir el número de clases (8). En la parte inferior derecha en la sección 

Break Values se pueden ingresar manualmente los límites de cada clase (p.ej. valores de 

pendiente en porcentaje de la Tabla 3). 

Output ráster.- Selecciona un directorio o geodatabase para almacenar el archivo ráster 

reclasificado de pendiente. 

Imagen 21: Ráster de pendiente reclasificado 
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10.5.  Generación de contornos 

Los contornos son líneas que conectan puntos de igual valor que representan fenómenos 

continuos (Huisman & A. de By, 2009). Los contornos se denominan isolíneas, pero 

también pueden tener términos específicos según el fenómeno. Cuando se las usa para 

representar la elevación se denominan curvas de nivel (Imagen 22), isobaras para la 

presión atmosférica, isoyetas para la precipitación, isotermas para la temperatura o 

isócronas para el tiempo (Olaya, Sistemas de Información Geográfica, 2014). 

Imagen 22: Curvas de nivel (msnm) 

 

 

El proceso para generar isolíneas de todo tipo es similar. Si se requiere crear curvas de 

nivel se necesita de un DEM como información de entrada. Las isolíneas se generan con 
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la herramienta Contour, ubicada en: 

ArcToolbox > Spatial Analyst Tools > Surface 

Imagen 23: Configuración de los parámetros de la herramienta Contour 

 

La configuración de los parámetros de la herramienta Contour (Figura 46) se detalla a 

continuación: 

Input raster.- Selecciona el ráster que contiene los valores (para generar curvas de nivel 

se requiere un ráster DEM, isoyetas un ráster de precipitación, para isotermas un ráster 

de temperatura). 

Output polyline features.- Selecciona el directorio o geodatabase para almacenar la capa 

de líneas (curvas de nivel). 

Contour interval.- Defini el intervalo entre isolíneas. Es importante tomar en cuenta la 

resolución del ráster, por ejemplo, si el DEM tiene una resolución de 30 metros, no se 

recomienda crear curvas de nivel menores a 30 metros. 

Base contour.- Opcionalmente se puede asignar un valor de nivel base. 

Z factor.- Opcionalmente se puede asignar un factor de conversión para generar la 

isolíneas. Se usa para realizar conversiones de unidades (de metros a pies). 
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TALLERES 
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11. UN RECORRIDO RÁPIDO POR EL TUTORIAL PARA GENERAR UNA 

GEODATABASE 

Es fácil crear un geodatabase y agregarle comportamiento, y el uso de las herramientas de 

administración de datos de ArcGIS Desktop no requiere programación alguna. Al 

consultar y editar la geodatabase en ArcMap, que es la aplicación de edición, análisis y 

creación de mapas a partir de los datos, puede aprovechar facilidad los datos y el 

comportamiento de la geodatabase sin necesidad de realizar ninguna operación de 

personalización. 

Este tutorial le permite explorar las funciones de la geodatabase utilizando una licencia 

ArcEditor o ArcInfo de ArcGIS Desktop. Puede completar este tutorial a su propio ritmo, 

sin necesidad de ayuda adicional. Este tutorial incluye ocho ejercicios, cuya realización 

requiere entre 10 y 20 minutos por ejercicio. Los ejercicios son acumulativos; debe 

completarlos en orden. 

En este tutorial, utilizará ArcCatalog y ArcMap para crear una geodatabase que modele 

una red de suministro de agua. Agregará comportamiento a la geodatabase creando 

subtipos, reglas de validación, relaciones y una red geométrica. Puede utilizar ArcMap 

para sacar partido del comportamiento editando algunas de las entidades existentes en la 

geodatabase y agregando algunas entidades nuevas. 

El área de estudio de estos ejercicios es una parte de una ciudad imaginaria. Junto con el 

software se proporcionan una geodatabase que contiene la mayoría de los datos, una 

cobertura que representa la toma de agua y una tabla INFO que representa los datos de los 

propietarios de las parcelas. Importará la cobertura y la tabla INFO a la geodatabase; a 

continuación, modificará sus propiedades para incorporar comportamiento. 

Los dataset para el tutorial fueron creados por ESRI, que utilizó para ello un esquema de 

base de datos similar al de la ciudad de Montgomery (Alabama). Los datos son totalmente 

ficticios y no tienen nada que ver con la auténtica ciudad de Montgomery. Puede 

actualizar, corregir o modificar esta información sin notificación previa. 
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EJERCICIO 1: 

Organizar los datos en el catálogo 

Antes de comenzar el tutorial, debe buscar y organizar los datos que necesitará. Lo cual 

se puede llevar a cabo a través de la ventana Catálogo en ArcMap o de la aplicación 

ArcCatalog. 

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de ArcGIS 

Objetivo: 

Conéctese a los datos del tutorial y consúltelos. 

 

Conectarse a los datos 

 En el catálogo, el acceso a los datos se obtiene a través de la conexión de base de datos o 

carpeta. Las conexiones de la base de datos se utilizan para tener acceso a las geodatabases 

de ArcSDE. 

Este tutorial utiliza las geodatabases del archivo. El acceso a la geodatabase del archivo 

se obtiene a través de las conexiones a carpetas. Entre los datos a los que se puede tener 

acceso a través de las conexiones a carpetas se incluyen las geodatabases personales, 

shapefiles y coberturas. 

En una conexión a una carpeta, podrá ver con rapidez las carpetas y fuentes de datos que 

contiene. Ahora podrá comenzar a organizar los datos mediante la creación de una 

conexión a carpetas para los mismos en ArcCatalog. 

Pasos: 

1. Para iniciar ArcCatalog, haga clic en Inicio > Todos los programas > ArcGIS > 

ArcCatalog 10. 

2. Haga clic en el botón Conectar a carpeta en la barra de herramientas estándar de 

ArcCatalog. Se abre el cuadro de diálogo Conectar a carpeta. 
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3. Navegue hasta la carpeta BuildingaGeodatabase en la unidad local donde haya 

instalado los datos del tutorial. 

4. Haga clic en Aceptar en el cuadro de diálogo Conectar a carpeta para establecer 

una conexión a carpetas. 

La nueva conexión a carpetas aparece ahora en el árbol de catálogo. Ahora podrá tener 

acceso a todos los datos necesarios para el tutorial a través de esa conexión. 

Explorar los datos 

Antes de empezar a modificar la geodatabase, explore los datasets que se proporcionan 

para el tutorial. 

Pasos: 

1. Haga clic en el signo más junto a la carpeta BuildingaGeodatabase para ver los 

datasets que contiene. 

2. Haga clic en la cobertura de las tomas en la carpeta para seleccionarla. 

3. Haga clic en la ficha Vista previa para ver la geometría de las tomas. 

4. Haga clic en el signo más junto a la geodatabase de Montgomery, a continuación, 

haga doble clic en cada dataset de entidades. De esta forma se expanden los 

datasets de entidades para que pueda ver todas las clases de entidad en cada dataset 

de entidades. 

5. Haga clic en la tabla owners.dat INFO en la carpeta BuildingGeodatabase. 

Tenga en cuenta que el tipo Vista previa cambia automáticamente a Tabla y muestra los 

registros de la tabla. Esta tabla contiene la información del propietario para la clase de 

entidad Parcelas en la geodatabase de Montgomery. En la parte siguiente de este ejercicio, 

importará esta tabla en la geodatabase y creará las relaciones entre las parcelas y sus 

propietarios. 

Ahora que ha encontrado y organizado los datos en ArcCatalog, está preparado para iniciar 

la primera tarea del tutorial: importar datos en la geodatabase. 
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EJERCICIO 2:  

Importar datos en la geodatabase 

Antes de poder empezar a agregar comportamientos a los datos, es preciso que los coloque 

en la geodatabase. Va a importar los datasets tomas y owner.dat. en la geodatabase de 

Montgomery. 

La cobertura de tomas contiene tomas de agua para el dataset de agua de Montgomery, y 

la tabla INFO owner.dat ya contiene información del propietario correspondiente a las 

entidades de la parcela de la geodatabase. 

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Importe una cobertura y una tabla INFO. 

Cree los alias para una clase de entidad y sus columnas. 

 

Importar una cobertura 

Pasos: 

1. En ArcCatalog, haga clic con el botón derecho en el dataset de entidades Water en 

la geodatabase de Montgomery, señale Importar, a continuación, haga clic en Clase 

de entidad (multiple). 

Esta herramienta se utiliza para especificar la cobertura de entrada, la geodatabase 

de salida y la clase de entidad de salida. Dado que esta herramienta se abrió al 

hacer clic con el botón derecho en un dataset de entidades, la geodatabase de salida, 

Montgomery y el dataset de entidades Water ya están rellenados. 

Existen diversas formas de establecer datasets de entrada y salida. También puede 

arrastrar un dataset desde la jerarquía de ArcCatalog o desde la ficha Contenido y 

colocarlos en el cuadro de texto. De forma alternativa, puede hacer clic en el botón 
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Explorar para abrir el miniexplorador de ArcCatalog y navegar hasta el dataset o 

escribir el nombre completo de la ruta hasta el dataset en el cuadro de texto. 

2. Haga clic en el botón Explorar, navegue hasta la clase de entidad de arco en la 

cobertura de tomas y haga clic en Añadir. 

3. Haga clic en Aceptar para ejecutar la herramienta Clase de entidad a geodatabase 

(múltiple). 

Mientras la herramienta se ejecuta, aparece una barra de progreso en la esquina 

inferior derecha de ArcCatalog. Cuando la herramienta finaliza su ejecución, 

aparece un mensaje emergente. Puede hacer clic en él para abrir el panel 

Resultados y ver cualquier mensaje que se hubiera generado al ejecutar la 

herramienta. 

La clase de entidad laterals_arc está ahora en el dataset de entidades Water. 

4. En la jerarquía ArcCatalog, navegue a la clase de entidad laterals_arc y haga clic 

en ella. 

5.  Presione la tecla F2, a continuación, escriba Laterals para cambiar el nombre de 

la clase de entidad. 

6. Haga clic en la ficha Vista previa para ver las entidades. 

Crear los alias para una clase de entidad y sus campos 

La geodatabase permite crear alias para campos, tablas y clases de entidad. Un alias es un 

nombre alternativo para referirse a esos elementos. Al contrario de lo que sucede con los 

nombres verdaderos, los alias pueden contener caracteres especiales, como espacios, 

porque no tienen que respetar las restricciones de nomenclatura de objetos de las bases de 

datos. 

Al utilizar los datos con alias en ArcMap, el nombre del alias se utiliza automáticamente 

para las clases de entidad, tablas y campos. Sin embargo, en ArcCatalog, estos elementos 

se representan siempre por sus nombres verdaderos. 

Pasos: 

1. Haga clic con el botón derecho en la clase de entidad Laterals en el dataset de 

entidades 

Water y haga clic en Propiedades. 

2. Haga clic en la ficha General. 

3. Escriba Water laterals en el cuadro de texto Alias. 
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4. Haga clic en la ficha Campos. 

5. Haga clic en el campo OBJECTID y escriba Feature identifier para su alias. 

6. Repita este proceso para asignar alias a los siguientes campos: 

Campo Alias 

Forma Campo Geometría 

DEPTH_BURI Profundidad de enterramiento 

RECORDED_L Longitud registrada 

FACILITY_I Identificador de la instalación 

DATE_INSTA Fecha de instalación 

TYPECODE Código del subtipo 

 

7. Cuando termine de agregar todos los alias, haga clic en Aceptar para cerrar el 

cuadro de diálogo Propiedades de Clase de entidad. 

Ahora que ha importado la clase de entidad Laterals en la geodatabase y ha agregado 

algunos alias, está preparado para importar la tabla INFO owner.dat. 

Importar la tabla INFO 

La tabla INFO owner.dat contiene información del propietario correspondiente a las 

parcelas en la clase de entidad Parcelas en la geodatabase de Montgomery. Para poder 

crear relaciones entre las parcelas y sus propietarios, la información del propietario se 

debe importar en la geodatabase de Montgomery. Utilice la herramienta de importación 

Tabla (simple) para importar la tabla INFO owner.dat en la geodatabase de Montgomery. 

A continuación, creará los alias para la tabla. 

Pasos: 

1. Haga clic con el botón derecho en la geodatabase de Montgomery, señale Importar 

y, a continuación, haga clic en Tabla (simple). 

2. Arrastre y suelte la tabla INFO owners.dat desde el árbol de catálogo hasta el 

cuadro de texto. Filas de entrada del cuadro de diálogo Tabla a Tabla. 
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3. Escriba Owners en el cuadro de texto Tabla de Salida. 

4. Haga clic en Aceptar. 

5. Cuando la herramienta finalice, haga clic en la tabla Owners en la geodatabase de 

Montgomery en el árbol de catálogo. 

6. Haga clic en la ficha Vista previa. 

7. Haga clic con el botón derecho en la tabla Owners y haga clic en Propiedades para 

ver las propiedades de la tabla. 

8. Escriba Parcel owners para el alias de esta tabla. 

9. Haga clic en la ficha Campos y escriba los siguientes alias de campo: 

Campo Alias 

OBJECTID Identificador de objetos 

OWNER_NAME Nombre del propietario 

OWNER_PERCENT Propiedad del porcentaje 

DEED_DATE Fecha del título 

10. Haga clic en Aceptar. 

Los datos en la cobertura de tomas y en la tabla INFO de owners.dat están ahora en la 

geodatabase de Montgomery. 

Ahora puede aprovechar las capacidades de la geodatabase si aplica el comportamiento a 

los datos. Para comenzar con esta tarea, cree subtipos y dominios de atributo.  

 

 

 

 

 

 

EJERCICIO 3: 
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 Crear subtipos y dominios de atributo 

Una de las ventajas de almacenar los datos en una geodatabase es que puede definir reglas 

sobre cómo se pueden editar los datos. Definirá estas reglas creando un nuevo dominio de 

atributo para los diámetros laterales; creando los subtipos para la clase de entidad Laterals; 

y asociando el nuevo dominio, los dominios existentes y los valores predeterminados a 

campos para cada subtipo. 

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Cree un dominio de geodatabase, cree subtipos y 

defina valores predeterminados para los subtipos. 

 

Los dominios de atributo son reglas que describen los valores legales de un tipo de campo. 

Varias clases de entidad y tablas pueden compartir dominios de atributo almacenados en 

la base de datos. Sin embargo, no todos los objetos de una clase de entidad o tabla tienen 

que compartir los mismos dominios de atributo. 

Por ejemplo, en una red de abastecimiento de agua, suponga que sólo las tomas de bocas 

de riego pueden tener una presión de entre 40 y 100 PSI, mientras que las tomas de agua 

de servicio pueden tener una presión de entre 50 y 75 PSI. Para forzar esta restricción 

utilizaría un dominio de atributo. Para implementar este tipo de regla de validación, no 

tiene que crear clases de entidad independientes para tomas de boca de riego y tomas de 

agua de servicio, pero es posible que desee poder distinguir entre estos tipos de tomas de 

agua para establecer un conjunto independiente de dominios y valores predeterminados. 

Puede hacerlo mediante subtipos. 

Para obtener más información sobre los subtipos y dominios de atributo, consulte Un 

recorrido rápido por los subtipos y Un recorrido rápido por los dominios de atributo. 

Crear un dominio de atributo 
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Utilizará ArcCatalog para crear un nuevo dominio de atributo de valor codificado. Este 

nuevo dominio describirá un conjunto de diámetros de tubería válidos para la nueva clase 

de entidad Laterals. 

Pasos: 

1. Haga clic con el botón derecho en la geodatabase de Montgomery y haga clic en 

Propiedades. Esto abre el cuadro de diálogo Propiedades de la Base de datos. 

2. Haga clic en la ficha Dominios. 

3. Haga clic en el primer campo vacío en Nombre del Dominio y escriba LatDiameter 

para el nombre del nuevo dominio. 

4. En el campo Descripción, escriba Valid diameters for water laterals.  

Ahora especificará las propiedades del dominio. Estas propiedades incluyen el tipo 

de campo al que puede estar asociado este dominio, el tipo de dominio que es; 

valor codificado o rango, las políticas de combinación y división y los valores 

válidos para el dominio. 

Un dominio de rango describe un intervalo válido de valores numéricos y un 

dominio de valor codificado describe un conjunto de valores válidos. En este caso, 

creará un nuevo dominio de valor codificado. 

Todos los dominios también tienen políticas de combinación y división. Cuando 

una entidad se divide o se combina, ArcGIS consulta estas políticas para 

determinar los valores para un atributo determinado de la entidad o entidades 

resultantes. 

5. En Propiedades de dominio, haga clic la lista desplegable para Tipo de campo y 

haga clic en Flotante. Esto define el tipo de datos de la columna a la que se puede 

aplicar el dominio. 

Escriba los códigos o valores válidos, para el dominio de valor codificado, y para 

cada código, deberá proporcionar una descripción fácil de usar. Como verá más 

adelante en el tutorial, ArcMap utiliza la descripción fácil de usar, no el código, 

para los valores de campos que tienen dominios de valor codificado asociados a 

ellos. 

6. Haga clic en el primer campo vacío en la columna Código en Valores codificados: 

y escriba. 

7. Haga clic en el campo Descripción situado al lado y escriba 13" en la descripción 

del código. 
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8. Agregue los siguientes valores codificados a la lista: 

Código Descripción 

10 10'' 

8 8'' 

6 6'' 

4 4'' 

3 3'' 

2.25 2 1/4'' 

2 2'' 

1.5 1 1/2'' 

1.25 1 1/4'' 

1 1'' 

0.75 3 1/4'' 

-9 Desconocido 

 

9. Haga clic en Aceptar para cerrar el cuadro de diálogo Propiedades de la Base de 

datos. Este dominio se ha agregado a la geodatabase. 

Crear los subtipos y asociar valores predeterminados y dominios 

Ahora creará los subtipos para la clase de entidad Laterals y asociará los dominios y 

valores predeterminados a los campos para cada subtipo. Con la creación de subtipos, no 

todas las entidades de tomas de agua tienen que tener los mismos dominios, valores 

predeterminados o (como verá más adelante en el tutorial) reglas de conectividad. 

Pasos: 

1. Haga doble clic en el dataset de entidades Water en la geodatabase de Montgomery 

para abrirlo. 

2. Haga clic con el botón derecho en la clase de entidad Laterals y haga clic en 

Propiedades. Esto abre el cuadro de diálogo Propiedades de Clase de entidad. 

3. Haga clic en la ficha Subtipos. 
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Ahora especificará el campo de subtipo para esta clase de entidad. El campo de 

subtipo contiene los valores que identifican el subtipo al que pertenece una entidad 

determinada. 

4. Haga clic en la flecha de la lista desplegable Campo de subtipo y a continuación 

en TYPECODE. Ahora agregará los códigos del subtipo y sus descripciones. Al 

agregar un nuevo subtipo, asigne valores predeterminados y dominios a algunos 

de sus campos. 

5. Haga clic en el campo Descripción al lado del código de subtipo 0 bajo Subtipos 

y escriba Desconocido como descripción. 

6. En Valores y dominios predeterminados, haga clic en el campo Valor 

predeterminado al lado del campo H_CONFID y escriba 0 como valor 

predeterminado. 

 

7. Escriba 0 como valor predeterminado de los campos DEPTH_BURI y 

RECORDED_L. 

8. Para los campos WNM_TYPE y PWTYPE, escriba WUNKNOWN como valores 

predeterminados. 

9. Haga clic en el campo Valor predeterminado al lado del campo DIAMETER y 

escriba 8 como valor predeterminado. 
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10. Haga clic en la lista desplegable Dominio para el campo DIAMETER y haga clic 

en LatDiameter para establecerlo como dominio de atributo predeterminado para 

el subtipo Desconocido. 

 

11. Haga clic en el campo MATERIAL y escriba DI como valor predeterminado. 

12. Haga clic en Material en la lista desplegable Dominio para el campo MATERIAL. 

 

13. Agregue los siguientes subtipos: 

Código del subtipo Descripción 

1 Tomas de boca de riego 

2 Tomas contra incendios 

3 Tomas de servicio 
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14. Establezca los valores predeterminados y dominios de los campos DEPTH_BURI, 

RECORDED_L, MATERIAL y DIAMETER para cada uno de estos nuevos 

subtipos de igual modo que hizo para el subtipo Desconocido. 

15. Para el subtipo de tomas de boca de riego, establezca los campos WNM_TYPE y 

PWTYPE en WHYDLIN. 

16. Para el subtipo de tomas contra incendios, establezca los valores predeterminados 

de los campos WNM_TYPE y PWTYPE en WFIRELIN. 

17. Para el subtipo de tomas de servicio, establezca los valores predeterminados de los 

campos WNM_TYPE y PWTYPE en WSERVICE. 

Al agregar las nuevas entidades a una clase de entidad con subtipos en el entorno 

de edición de ArcMap, si no especifica un subtipo determinado, la nueva entidad 

tendrá asignado el subtipo predeterminado. Cuando haya agregado todos los 

subtipos a esta clase de entidad, puede establecer el subtipo predeterminado a partir 

de los que ha introducido. 

18. Haga clic en la flecha de la lista desplegable Subtipo predeterminado y haga clic 

en Service laterals para establecerlo como subtipo predeterminado. 

 

19. Haga clic en Aceptar. 

Ahora ha agregado el comportamiento a la geodatabase agregando dominios y creando 

subtipos. Ahora agregará algún comportamiento adicional a la geodatabase creando 

relaciones. Consulte Ejercicio 4: crear relaciones entre objetos. 
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EJERCICIO 4:  

Crear relaciones entre objetos 

En el Ejercicio 2: importar datos en la geodatabase, importó en la geodatabase de 

Montgomery una tabla INFO que contenía los objetos de propietario. La geodatabase ya 

tiene una clase de entidad, Parcels, que contiene los objetos de la parcela. Ahora creará 

una clase de relación entre las parcelas y los propietarios de forma que al utilizar los datos 

en ArcMap, pueda averiguar con facilidad a qué propietarios pertenecen las parcelas. 

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Crear una clase de relación entre una clase de 

entidad y una tabla no espacial. 

 

Pasos: 

1. Haga clic con el botón derecho en el dataset de entidades Landbase en la 

geodatabase de Montgomery, seleccione Nuevo y, a continuación, haga clic en 

Clase de relación. Se abre el asistente Nueva clase de relación. El primer panel del 

asistente se utiliza para especificar el nombre, origen y clase de entidad o tabla de 

destino para la nueva clase de relación. 

2. Escriba ParcelOwners en el cuadro de texto Nombre de la clase de relación. 

3. Haga clic en Owners en la lista Tabla/clase de entidad de origen. 

4. Haga doble clic en el dataset de entidades Landbase en la lista Tabla/clase de 

entidad de destino. 

5. Haga clic en Parcels. Así se designa a la clase de entidad Parcels como clase de 

entidad de destino. 
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6. Haga clic en Siguiente. 

El siguiente panel se utiliza para especificar el tipo de clase de relación que está 

creando. Está creando una clase de relación simple, dado que los propietarios y 

parcelas pueden existir en la base de datos independientemente entre sí. Por 

consiguiente, puede aceptar el tipo predeterminado, Relación simple (punto a 

punto). 

7. Haga clic en Siguiente. 

Ahora debe especificar las etiquetas de ruta y la dirección de notificación de 

mensajes. La etiqueta de ruta hacia delante describe la relación conforme se 

desplaza desde la clase de origen hasta la clase de destino, en este caso, desde 

Owners a Parcels. La etiqueta de ruta hacia atrás describe la relación cuando se 

desplaza en el otro sentido, desde Parcels a Owners. 

La dirección de notificación de mensajes describe cómo se transfieren los mensajes 

entre objetos relacionados. La notificación de mensajes no es necesaria para esta 

clase de relación, de forma que puede aceptar el valor predeterminado de Ninguno. 

8. Escriba owns para la etiqueta de ruta hacia delante. 

9. Escriba is owned by para la etiqueta de ruta hacia atrás. 
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10. Haga clic en Siguiente. 

Ahora especificará la cardinalidad de la relación. La cardinalidad describe el 

número de objetos posible en la clase de entidad de destino o tabla que se puede 

relacionar con un objeto en la clase de entidad del origen o tabla. 

11. Haga clic en 1-M (one-to-many) para especificar que un propietario puede tener 

varias parcelas. 

12. Haga clic en Siguiente. 

Ahora debe especificar si la nueva clase de relación tendrá atributos. En este 

ejemplo, la clase de relación ParcelOwners no requiere atributos, que es el valor 

predeterminado. 

13. Haga clic en Siguiente. 

El siguiente paso consiste en especificar la clave principal en la tabla de origen 

(Owners) y el campo de clave externa incrustado en la clase de entidad de destino 

(Parcels). Se relacionarán entre sí los valores de Owners y Parcels que tengan el 

mismo valor en estos campos. 

14. Haga clic en la primera flecha de lista desplegable en Seleccione el campo de clave 

principal en la tabla/clase de entidad de origen y haga clic en PROPERTY_ID. 

15. Haga clic en la segunda flecha de lista desplegable en el cuadro de diálogo y haga 

clic en PROPERTY_I para la clave externa incrustada en la clase de entidad de 

destino. 
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16. Haga clic en Siguiente. 

Aparece una página de resumen. 

17. Revise la página de resumen para asegurarse de que la información es correcta. 

18. Haga clic en Finalizar. 

Ahora ha agregado un segundo tipo de comportamiento a la geodatabase: 

relaciones. 

A continuación, seguirá agregando comportamiento a la geodatabase creando una red 

geométrica y definiendo reglas de conectividad. Vea Ejercicio 5: generar una red 

geométrica. 
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EJERCICIO 5:  

Generar una red geométrica 

Las clases de entidad almacenadas en el mismo dataset de entidades pueden participar en 

una red geométrica. Las redes geométricas modelan sistemas de red de flujo direccionado 

como, por ejemplo, redes de abastecimiento de agua. Generará una red geométrica a partir 

de las clases de entidad en el dataset de entidades Water en la geodatabase de 

Montgomery. A continuación, creará reglas de conectividad para definir qué entidades 

pueden conectar entre sí en la red. 

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Crear una red geométrica.  

 

Crear la red de abastecimiento de agua 

Pasos: 

1. Para iniciar ArcCatalog, haga clic en Inicio > Todos los programas > ArcGIS > 

ArcCatalog 10. 

2. Desplácese hasta la geodatabase de Montgomery en Conexiones a carpetas. 

3. Expanda la geodatabase de Montgomery. 

4. Haga clic con el botón derecho en el dataset de entidades Water en la geodatabase 

de Montgomery, seleccione Nuevo, a continuación, haga clic en Red geométrica. 

Se abre el asistente Nueva red geométrica. 

5. Haga clic en Siguiente. 

6. Escriba WaterNet como nombre de la red geométrica. 

7. Haga clic en Sí para alinear las entidades. 

8. Escriba 0,5 en el cuadro de texto al lado de Pies. 

El cuadro de diálogo debería tener un aspecto similar al siguiente. 
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9. Haga clic en Siguiente. 

Ahora debería seleccionar qué clases de entidad del dataset de entidades 

participarán en la red geométrica. 

10. Haga clic en Seleccionar Todo. 

Todas las clases de entidad de la lista participarán en la red. 

 

 

11. Haga clic en Siguiente. 

La opción de excluir entidades con determinados atributos facilita la 

administración del estado de partes de la red si necesita eliminar la red y volver a 

generarla después de haber estado trabajando con ella durante un tiempo. En el 

siguiente panel, tendrá la opción de no excluir las entidades. 

12. Haga clic en No, para que todas las entidades participen en la red geométrica. 
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13. Haga clic en Siguiente. 

En el siguiente cuadro de diálogo, debe especificar qué clases de línea se 

convertirán en clases de entidad de eje complejo en la red geométrica. Las 

entidades de borde complejo no se dividen en dos entidades por la conexión de 

otra entidad a lo largo de su longitud; por tanto, resultan útiles para modelar 

conductos de agua, que pueden tener varias tomas conectadas a los mismos. De 

forma predeterminada, todas las clases de entidad de línea son clases de entidad de 

eje simple. 

En el mismo cuadro de diálogo, debe especificar las clases de entidad de cruce, si 

las hay, que pueden actuar como fuentes y sumideros en la red. Las fuentes y 

sumideros se utilizan para determinar la dirección del flujo en la red. 

14. En la fila para Distribmains, haga clic en Eje simple en la columna Rol. 

15. Seleccione Eje complejo en la lista. 

Esto cambia la función para la clase de entidad Distribmains de borde simple a 

borde complejo. 

16. En la fila para la clase de entidad Tanks, haga clic en el menú desplegable en 

Orígenes y sumideros y, a continuación, haga clic en Sí. 

17. En la fila para Transmains, haga clic en Eje simple en la columna Rol, a 

continuación, seleccione Eje complejo en la lista. 

Esto cambia la función para la clase de entidad Transmains de borde simple a borde 

complejo. 
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18. Haga clic en Siguiente. 

Ahora puede asignar los pesos de red. Un peso de red describe el coste de atravesar un 

elemento en la red lógica como, por ejemplo, la caída de presión cuando el agua fluye a 

través de una tubería. 

19. Esta red geométrica no requiere pesos, que es el valor predeterminado, por tanto 

haga clic en 

Siguiente. 

 

Al hacer clic en Siguiente, se abre una página de resumen. 

20. Haga clic en Finalizar después de revisar la página de resumen. 

Aparece un indicador de progreso que muestra el progreso para cada etapa del proceso de 

generación de la red. 

Recibirá un mensaje de error que indica que la red se ha generado, pero con errores. 
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21. Haga clic en Aceptar para cerrar el cuadro de mensaje. 

22. Puede ver los errores aparecidos al generar la red geométrica mediante una vista 

previa de la tabla WaterNet_BUILDERR. 

23. Haga clic en la tabla WaterNet_BUILDERR en la jerarquía de catálogo y haga clic 

en la ficha 

Vista previa para ver las entradas en esta tabla. Se muestran dos registros. 

 Sugerencia:   Si recibió más de dos errores, elimine la red geométrica y repita los pasos 

para volver a crearla. Asegúrese de completar correctamente todos los pasos de este 

ejercicio para crear la red geométrica. Si sigue teniendo más de dos errores, es posible que 

no haya finalizado los 5 ejercicios precedentes. Este tutorial es acumulativo; debe finalizar 

los ejercicios anteriores antes de hacer este. 

A continuación, establecerá las reglas de conectividad de la red de abastecimiento de agua. 

Crear reglas de conectividad 

Las reglas de conectividad de red limitan el tipo de entidades de red que se pueden 

conectar entre sí y el número de entidades de cualquier tipo concreto que se pueden 

conectar a entidades de otro tipo. Estableciendo estas reglas, puede mantener la integridad 

de la conectividad de red en la base de datos. 

Pasos: 

1. Haga clic con el botón derecho en la red geométrica WaterNet en el dataset de 

entidades y haga clic en Propiedades. 

Se abre el cuadro de diálogo Propiedades de Red Geométrica, que proporciona 

información sobre las clases de entidad que participan en la red y una lista de los 

pesos de red. También puede agregar, eliminar y modificar reglas de conectividad 

mediante este cuadro de diálogo. 

2. Haga clic en la ficha Conectividad. 
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Esta ficha le permite agregar y modificar las reglas de conectividad de la red 

geométrica. 

En primer lugar creará una nueva regla de conexión entre confluencias y bordes, 

que determina que las bocas de riego se pueden conectar a tomas de bocas de riego; 

también indica que cuando se crea una toma de boca de riego, se debe colocar una 

entidad de cruce de boca de riego en su extremo libre. 

3. Haga clic en la flecha de la lista desplegable y haga clic en laterals. 

4. Haga clic en Hydrant laterals en la lista Subtipos de la clase de entidad. 

 Ahora hará clic en los tipos de cruces a los que se pueden conectar la toma de boca 

de riego en la red. Por simplicidad, las tomas de bocas de riego solo se pueden 

conectar a bocas de riego. 

5. Active Hydrants en la lista Subtipos de la red. 

También debería especificar que al crear una toma de boca de riego, si un extremo 

de la toma no está conectado a otro borde o confluencia, entonces la boca de riego 

se coloca en ese extremo. 

6. Haga clic en el signo más al lado de Hydrants en la lista Subtipos de la red. 

Se expande el subtipo Hydrants. 

7. Haga clic con el botón derecho en Hydrants bajo el subtipo Hydrants y haga clic 

en 

Establecer como Por Defecto. 

Aparece una D azul al lado del subtipo de boca de riego, indicando que es el cruce 

predeterminado para este subtipo de borde. 

Ahora creará una nueva regla de conexión entre bordes que determina que las 

tomas de bocas de riego se pueden conectar a las redes de distribución mediante 

llaves de paso, conexiones en T y bridas. El cruce predeterminado para las 

conexiones entre tomas de bocas de riego y conductos principales de distribución 

serán las llaves de paso. 

8. Haga clic en el signo más junto a Distribmains en la lista Subtipos de la red para 

expandirla. 

9. Active Distribmains, que aparece debajo del subtipo Distribmains. 

Dado que ha marcado un borde en la lista de subtipos de red, se activa la lista de 

subtipos de confluencia de red. En esta lista, puede especificar a qué tipos de 

confluencia se pueden conectar la toma de bocas de riego y conductos de 

distribución. 
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10. Haga clic en el signo más para expandir Fittings en la lista Junctions subtype. 

11. Active Tap, Tee y Saddle, en ese orden, bajo el subtipo de confluencia Fittings. 

Tap tiene una D azul al lado, lo que indica que es el tipo de cruce predeterminado. 

12. Además en la lista Junctions subtype, active WaterNet_Junctions, que es el tipo de 

confluencia de red genérico o predeterminado. 

13. Haga clic en Aceptar. 

Ahora ha agregado el comportamiento a la geodatabase definiendo reglas de 

conectividad. Habitualmente tendrá que definir muchas más reglas de conectividad 

para una red. Sin embargo, para este tutorial, solo tiene que definir las reglas de 

conectividad aquí especificadas. 

En el Ejercicio 6: crear anotaciones, creará una anotación vinculada a entidad para 

la nueva clase de entidad de toma de boca de riego. 
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Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Entidades de etiqueta basadas en subtipos y 

dimensiones. Convertir etiquetas en anotación. 

 

EJERCICIO 6: 

Crear Anotaciones 

En Ejercicio 1: organizar los datos en el catálogo, examinó las clases de entidad existentes 

en la geodatabase de Montgomery. Una de estas clases de entidad contenía una anotación 

que se vinculó a las entidades en las clases de entidad Distribmains. Seguidamente, 

importó la toma de agua desde una cobertura en el dataset de entidades Water. Ahora 

creará etiquetas para las tomas de agua en ArcMap y las convertirá en una clase de entidad 

de anotación que está vinculada a las tomas. 

 

 

 

 

 

 

Crear etiquetas para los subtipos de tomas 

Inicie ArcMap y agregue la clase de entidad Laterals. 

Pasos: 

1. Para iniciar ArcMap, haga clic en Inicio > Todos los programas > ArcGIS > 

ArcMap 10. 

2. Establezca la geodatabase de Montgomery como predeterminada, dado que se trata 

de la geodatabase que utilizará en este tutorial. Para ello, haga clic en el botón de 

exploración en el cuadro de diálogo ArcMap - Introducción. 
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3. Desplácese hasta la ubicación de la carpeta de tutorial BuildingaGeodatabase, 

seleccione la geodatabase de Montgomery, a continuación, haga clic en Añadir. 

4. Haga clic en Aceptar para abrir un nuevo mapa vacío. 

5. Haga clic en el botón Ventana de catálogo en la barra de herramientas estándar 

para abrir la Ventana de Catálogo. 

6. Desplácese hasta la geodatabase de Montgomery en la ventana Catálogo. 

7. Expanda el dataset de entidades Water. 

8. Haga clic en la clase de entidades Laterals, mantenga presionado el botón 

izquierdo del ratón y arrastre la clase de entidad desde la ventana Catálogo a la 

ventana de ArcMap. 

Dado que creó los subtipos para la clase de entidad Laterals, cada subtipo se dibuja 

automáticamente con símbolos únicos. Creará las clases de etiqueta diferentes para los 

subtipos. 

9.   Haga clic con el botón derecho en la clase de entidad Laterals en la tabla de 

contenido de ArcMap y haga clic en Propiedades. 

Se abre el cuadro de diálogo Propiedades de capa. 

10.   Haga clic en la ficha Etiquetas. 

11.   Active el cuadro Etiquetar entidades en esta capa. 

12. Haga clic en la flecha de la lista desplegable Método y haga clic en Definir 

clases para las entidades y etiquetar cada clase de manera distinta. 

13.   Haga clic en Obtener Clases de Símbolos. 
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Ahora la capa tiene varias clases de etiqueta definidas, una para cada subtipo y una para 

otros valores. Deje abierto el cuadro de diálogo Propiedades de capa; lo utilizará en la 

próxima sección. 

Definir las etiquetas para la toma de bocas de riego. 

Los distintos subtipos de tomas tienen funciones diferentes en el sistema de distribución 

de agua. Por ejemplo, las tomas de servicio llevan agua desde el conducto principal de 

distribución a zonas residenciales o de negocios y la toma de bocas de riego llevan agua 

desde el conducto principal a las bocas de incendio. Hará que las etiquetas de las tomas 

de bocas de riego sean rojas para facilitar que los usuarios del mapa diferencien las tomas 

de bocas de riego de otras tomas. 

Pasos: 

1. Haga clic en la lista desplegable Clase en la ficha Etiquetas del cuadro de diálogo 

2. Propiedades de capa y haga clic en Hydrant laterals. 

3. Haga clic en la flecha de la lista desplegable de color de texto y elija una muestra 

roja de la paleta. 

4. Haga clic en los botones de negrita, N y cursiva, N. 

5. Haga clic en Expresión. 

6. Se abre el cuadro de diálogo Etiquetar Expresión. 

A veces se desean etiquetar las entidades con el contenido de un único campo. La lista 

desplegable Campo de Etiqueta le permite seleccionar un campo único para etiquetar las 

entidades. En otros momentos, es posible que desee crear más etiquetas complejas. El 

cuadro de diálogo Etiquetar Expresión le permite construir etiquetas concatenando uno o 

más campos y otro texto. También puede agregar lógica a la expresión de etiqueta 

mediante una secuencia de comandos. 

Para crear las etiquetas para la toma de boca de riego, cargará una expresión de etiqueta 

que se ha guardado en un archivo. 

7. Haga clic en Cargar. 

Esto abre un cuadro de diálogo que le permite desplazarse hasta el archivo que desea 

cargar. 
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Desplácese hasta la carpeta Capas en la carpeta del tutorial BuildingaGeodatabase. 

8. Seleccione el archivo lateral_exp.lxp y haga clic en Abrir. 

Esta expresión de secuencia de comandos evalúa la longitud de cada toma; si su valor es 

mayor que 200, etiqueta la toma con el contenido del campo DIAMETER, un espacio y 

el contenido del campo MATERIAL. Si la longitud es inferior a 200, etiqueta la toma con 

el contenido del campo DIAMETER. 

Ajustará esta expresión para las tomas de bocas de riego de forma que las tomas de bocas 

de riego superiores a 100 pies de longitud obtengan las etiquetas más completas. 

9. Haga clic en el cuadro Expresión del cuadro de diálogo Etiquetar Expresión y 

cambie el valor de la instrucción IF de 200 a 100. 

10. Haga clic en Verificar. 

Se prueba la expresión y se muestra un ejemplo. 

11. Haga clic en Aceptar en el cuadro de diálogo Verificación de etiquetas de 

expresión para cerrarlo. 

12. Haga clic en Aceptar en el cuadro de diálogo Etiquetar Expresión. 

Ha creado una expresión para la clase de etiqueta Hydrant laterals. 

13. Haga clic en Aplicar en la ficha Propiedades de capa Capas para aplicar los 

cambios. 

A continuación, creará expresiones para las clases de etiqueta de otros subtipos. 

Definir las etiquetas para la toma de servicio 

Las tomas de servicio tienden a ser más cortas que las tomas de bocas de riego. Para este 

ejercicio, solo es importante para mostrar el tipo material cuando son más largas de 200 

pies, de modo que volverá a cargar la expresión de etiqueta y la utilizará sin modificarla. 

Pasos: 

1. Haga clic en la lista desplegable Clase en el cuadro de diálogo Propiedades de capa 

y haga clic en Service laterals. 

2. Ahora puede configurar los parámetros de etiqueta para esta clase de etiqueta. 



IBSN: 978-9942-8705-3-7 

    Ciencia Digital Editorial  

69 

 

3. Utilice el mismo procedimiento que acaba de usar para definir las etiquetas para 

las tomas de bocas de riego, pero haga que las etiquetas sean negras y no modifique 

la expresión de etiqueta después de cargarlas. 

4.  Haga clic en Aplicar para aplicar los cambios. 

Definir las etiquetas de otra toma 

Ha cargado expresiones de etiqueta para la toma de bocas de riego y las tomas de servicio. 

Ahora definirá las etiquetas para tomas contra incendios, toma desconocida y la clase 

<todos los demás valores>. Dado que estas clases son menos comunes y solo el diámetro 

es de interés, utilizará únicamente el campo Diámetro para etiquetar estas entidades. 

Pasos: 

1. Haga clic en la flecha de la lista desplegable Clase y haga clic en Fire laterals. 

2.  Haga clic en la flecha de la lista desplegable Campo de Etiqueta y a continuación 

en DIAMETER. 

3.   Haga clic en Aplicar. 

4. Utilice el mismo procedimiento para establecer las etiquetas para las clases de 

etiqueta 

5. Desconocido y <todos los demás valores>. 

6. Haga clic en Aceptar en el cuadro de diálogo Propiedades de capa. 

Las etiquetas se dibujan en el mapa. Las tomas de bocas de riego se etiquetan en rojo y 

debido a la expresión de etiqueta, las más largas se etiquetan también con el tipo de 

material. 

Establecer la escala de referencia para las etiquetas 

Las etiquetas son dinámicas, se general al vuelo cuando se desplaza por el mapa y cuando 

hace zoom. De forma predeterminada, se dibujarán utilizando el mismo símbolo de 

tamaño, sin tener en cuenta la escala a la que hace zoom. No todas las entidades se pueden 

etiquetar usando una fuente de 8 puntos en toda la extensión de la clase de entidad, pero 

si hace zoom, habrá más espacio alrededor de las entidades, de modo que se dibujaran más 

etiquetas. 
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A diferencia de las etiquetas, la anotación es estática. Se almacenan entidades de 

anotación. Tienen una ubicación fija y una escala de referencia, de modo que al hacer 

zoom, el texto aumenta en la pantalla. Puede hacer que las etiquetas se comporten como 

anotación estableciendo una escala de referencia. Es aconsejable utilizar la escala a la que 

se usará normalmente el mapa. Al convertir las etiquetas en anotación, desea que la 

anotación tenga la referencia de escala correcta de modo que se dibuje al tamaño correcto, 

en relación a las entidades, en los mapas que cree. 

Pasos: 

1. Haga clic en la herramienta Acercar en la barra de herramientas ArcMap Tools y 

haga clic y arrastre un cuadro alrededor de algunas de las tomas en el borde este 

de los datos. 

2.  Escriba 1000 en el cuadro Escala y presione Intro. 

3. Ahora se dibujan más etiquetas en la pantalla. 

4. Ésta es la escala a la que normalmente se dibujarán los datos, de modo que ahora 

establecerá la escala de referencia del mapa y la anotación que crea a partir de la 

misma. 

5.   Haga clic en Lista por orden de dibujo en la tabla de contenido de ArcMap. 

6. Haga clic con el botón derecho en Capas en la tabla de contenido de ArcMap, 

seleccione Escala de referencia, a continuación, haga clic en Establecer Escala de 

Referencia. Ahora, al acercar o alejar el zoom, las etiquetas aumentarán o se 

reducirán. 

Convertir las etiquetas en anotación 

Esta sección se aplica sólo a ArcEditor y ArcInfo. 

 Ahora que se ha establecido la escala de referencia, puede convertir las etiquetas en 

anotación y almacenarlas en la geodatabase. Convertirá las clases de etiqueta en subtipos 

de una clase de entidad de anotación vinculada a entidad única. Este proceso requiere un 

puesto autorizado para ArcEditor o ArcInfo de ArcMap. Con un puesto de ArcView, 

puede crear la anotación a partir de etiquetas, pero no la anotación vinculada a entidad. 

Pasos: 
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1. Haga clic con el botón derecho en Capas en la tabla de contenido de ArcMap y 

haga clic en Convertir Etiquetas En Anotaciones.  

Se abre el cuadro de diálogo Convertir Etiquetas En Anotaciones. 

2. Haga clic en la columna Clases de entidad de anotación para la capa de entidades 

Water laterals y cambie el nombre de la clase de entidad de anotación de salida 

LateralsAnno. 

3. Haga clic en el icono de propiedades en Clases de entidad de anotación. Se abre el 

cuadro de diálogo Propiedades de Clase de la Entidad Anotación. 

4. Active el cuadro Requerir que el símbolo se seleccione en la tabla de símbolos. 

Esto reducirá el espacio de almacenamiento necesario en la geodatabase para la anotación. 

Cada entidad de anotación hará referencia a una tabla de simbología en la geodatabase, en 

lugar de almacenar toda la información de simbología propia. No podrá almacenar 

gráficos en esta clase de entidad de anotación.  

De forma predeterminada se activan las casillas de verificación de las dos opciones de 

comportamiento de edición de anotación vinculada a entidad. Se creará la nueva anotación 

cuando se agreguen nuevas tomas y la anotación existente se desplazará cuando las tomas 

se muevan o se cambie su forma. 

5. Haga clic en Aceptar para cerrar el cuadro de diálogo Propiedades de Clase de la 

Entidad Anotación. 

6. Haga clic en Convertir en el cuadro de diálogo Convertir Etiquetas En 

Anotaciones. 

También se crea una clase de relación que vincula la anotación a las tomas. Para ver esto, 

haga clic en la ficha Catálogo en ArcMap para abrir la ventana Catálogo. Haga clic con el 

botón derecho en el dataset de entidades Water en la geodatabase de Montgomery y haga 

clic en Actualizar. Se debería mostrar una nueva clase de relación Anotaciones dataset de 

entidades Water. 

7. Cierre ArcMap.  

Sugerencia:   No tiene que guardar el mapa, pero puede hacerlo si lo desea. 

Ha creado una clase de entidad de anotación en la geodatabase. Las clases de anotación 

dentro de la misma corresponden a las subclases de la clase de entidad de tomas. Algunas 

de estas clases de anotación tienen una simbología especial, además de lógica, para anotar 



IBSN: 978-9942-8705-3-7 

    Ciencia Digital Editorial  

72 

determinadas entidades con información adicional. Cuando la clase de entidad Laterals se 

edita en ArcMap, se crearán o modificarán las entidades de anotación correspondientes 

utilizando la expresión de simbología y anotación que ha definido. 
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Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Crear archivos de capa a partir de clases de entidad. 

EJERCICIO 7: 

Crear capas para los datos de la geodatabase 

Para hacer que la exploración y la simbología de los datos sean más cómodas, puede crear 

capas a partir de los datos de la geodatabase y utilizar dichas capas en ArcMap. La mayoría 

de las capas que pueda necesitar ya se han creado, y se almacenan en la carpeta Capas del 

directorio del tutorial. En este ejercicio, creará nuevas capas para las clases de entidad 

Laterals y LateralsAnno. 

 

 

 

 

 

 

 

 

Pasos: 

1. Para iniciar ArcCatalog, haga clic en Inicio > Todos los programas > ArcGIS > 

ArcCatalog10. 

2. Conéctese a la geodatabase de Montgomery en la carpeta de tutorial sobre 

generación de geodatabases. 

3. Haga clic con el botón derecho en la clase de entidad Laterals en el dataset de 

entidades Water y haga clic en Crear capa. 

Se abre el cuadro de diálogo Guardar capa Como, en el que se indican la ubicación 

y el nombre del archivo de capa. 

4. Acceda a la carpeta Capas en el directorio del tutorial y escriba Water Laterals 

como nombre de la nueva capa. 

5. Haga clic en Guardar.  

Se crea la nueva capa. 

Modificará las propiedades de la capa para agregar simbología. 
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6. Abra la carpeta Capas en el árbol de catálogo, haga clic con el botón derecho en la 

capa Water Laterals y, a continuación, haga clic en Propiedades. 

Se abre el cuadro de diálogo Propiedades de capa. 

Puede utilizar el cuadro de diálogo Propiedades de capa para modificar muchos 

aspectos de una capa, por ejemplo, su escala visible y transparencia. En este caso, 

modificará su simbología. 

7. Haga clic en la ficha Simbología. 

De forma predeterminada, se utiliza la clasificación de los valores únicos basada 

en el campo de subtipo para la simbología de la capa. Se trata del parámetro que 

desea, pero debe modificar la simbología de cada subtipo. 

8. Haga doble clic en la línea de color situada al lado de las tomas de boca de riego. 

Aparece el cuadro de diálogo Selector de Símbolo. 

Utilizará este cuadro de diálogo para establecer las propiedades de símbolo para 

las tomas. 

9. Haga clic en la flecha de la lista desplegable Color y haga clic en superficie púrpura 

de la paleta de colores para hacer que la línea sea púrpura. 

10. Escriba 1,5 en el cuadro de texto Anchura para aumentar el ancho de línea. 

11.   Haga clic en Aceptar. 

12. Repita los pasos 8 a 10 para las tomas contra incendios, convirtiendo el símbolo 

en una línea roja con un ancho de 1,5. 

13. Repita los pasos 8 a 10 para las tomas de servicio, convirtiendo el símbolo en una 

línea azul marino con un ancho de 1,5. 

14.  Haga clic en Aceptar para cerrar el cuadro de diálogo Propiedades de capa. 

Se ha completado la capa Water laterals. 

Ahora puede crear la capa de anotaciones para las tomas de agua. 

Crear la capa Lateral Diameter 

Pasos: 

1. Haga clic con el botón derecho en la clase de entidad LateralsAnno en el dataset 

de entidades Water y haga clic en Crear capa. 

2.  Desplácese hasta la carpeta Capas y escriba Water lateral diameter annotation 

como nombre de la nueva capa. 

3.  Haga clic en Guardar. 
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Se crea la nueva capa de anotaciones. Dado que esta capa señala a una clase de entidad de 

anotación, la simbología es una propiedad de la anotación, de modo que no se tiene que 

establecer en la capa. 

Establecer un rango de escala visible para la capa 

Las entidades de anotación son muy útiles dentro de un rango bastante estrecho de escalas 

de mapa en las que son legibles. Con frecuencia resulta útil establecer una escala mínima 

y máxima dentro de la que se dibujarán las clases de entidad de anotación. Puede hacer 

que este rango de escala visible sea una propiedad de la propia clase de entidad de 

anotación o establecerlo como propiedad de una capa que señale a la clase de entidad de 

anotación. Para clases de entidad de anotación grandes y en entornos multiusuario, el 

primer enfoque es mejor, porque es la manera más efectiva de evitar que el servidor 

solicite innecesariamente un gran número de entidades de anotación. 

En este ejercicio, suponga que los usuarios de esta clase de entidad agregarán normalmente 

la capa que ha creado en lugar de agregar la clase de entidad de anotación directamente. 

Pasos: 

1. En el árbol de catálogo, haga clic con el botón derecho en Water lateral diameter 

annotation.lyr y haga clic en Propiedades. 

Se abre el cuadro de diálogo Propiedades de capa. 

2. Haga clic en la ficha General. 

3.  Haga clic en el botón No mostrar la capa cuando se haga zoom y escriba 2500 en 

el cuadro de texto. 

4. Haga clic en Aceptar. 

Sugerencia:    

Para establecer el rango de escala para una clase de entidad de anotación, haga clic con el 

botón derecho en la clase de entidad de anotación en ArcCatalog, haga clic en Propiedades 

y, a continuación, haga clic en la ficha Clases de anotación. Puede establecer un rango de 

escala independiente para cada clase de anotación en la clase de entidad de anotación. 

Haga clic en el botón Rango de Escala para establecer las escalas visibles mínima y 

máxima. 

EJERCICIO 8:  
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Crear una topología 

En el Ejercicio 5: generar una red geométrica, creó una red geométrica. Una red 

geométrica es un tipo especializado de relación topológica que permite el seguimiento, 

análisis y edición de redes. En este ejercicio, creará una topología de geodatabase. Una 

topología de geodatabase le permite especificar reglas que controlan las relaciones 

espaciales de entidades en un dataset.  

Complejidad: 

Principiante 

Requisitos de datos: 

Configuración de datos de tutorial de 

ArcGIS 

Objetivo: 

Defina una topología para definir las relaciones espaciales entre dos clases de entidad. 

Crear una topología 

Creará la topología para regular dos tipos de relaciones espaciales en este dataset. La 

primera es que las parcelas no se deben superponer y la segunda es que las parcelas 

clasificadas como residenciales deben estar situadas dentro bloques también clasificados 

como residenciales. 

Pasos: 

1. Para iniciar ArcCatalog, haga clic en Inicio > Todos los programas > ArcGIS > 

ArcCatalog10. 

2. En el árbol de catálogo, desplácese hasta el dataset de entidades Landbase en la 

geodatabase de Montgomery. 
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Este dataset contiene varias clases de entidad. Creará una topología mediante dos clases 

de entidad, Parcels y Blocks. 

3. Haga clic con el botón derecho en la clase de entidad Landbase, seleccione Nuevo, 

a continuación, haga clic en Topología. 

Se inicia el asistente Nueva Topología. 

La primera página ofrece una breve descripción del asistente. 

4. Haga clic en Siguiente. 

El asistente presenta un nombre predeterminado y una tolerancia clúster para la 

topología. Aceptará el nombre predeterminado que ofrece el asistente. 

La tolerancia clúster predeterminada se basa en la tolerancia XY del dataset 

Landbase. 

5. Escriba 0.01 para establecer la nueva tolerancia clúster. 

6.  Haga clic en Siguiente. 

7. Active Blocks y Parcels 

Estas clases de entidad participarán en la topología Landbase. 

Una de las reglas topológicas que va a crear implicará a la clase de entidad Parcels 

y la otra estará entre un subtipo de Parcels y un subtipo de Blocks; de este modo, 

las clases de entidad Blocks y Parcels deben participar en la topología. Si una de 

estas clases de entidad ya estuviera participando en otra topología o red 

geométrica, o si se registraran como versionadas en una geodatabase multiusuario, 

no aparecería en la lista de clases de entidad disponibles para agregar a esta 

topología. 

8. Haga clic en Siguiente. 

La siguiente página del asistente le permite establecer el número de clasificaciones 

de la topología y la clasificación de cada clase de entidad en la topología. 

Las clasificaciones le permiten asegurarse de que las entidades recopiladas con 

más precisión no se alinean a la posición de otras recopiladas con menos precisión 

cuando se valida la topología. Por ejemplo, si estuviera incluyendo una clase de 

entidad que se recopiló utilizando una unidad de Sistema de posicionamiento 

global (GPS) de grado topográfico y una clase de entidad digitalizada a partir de 

un mapa de origen de escala 1:1.000.000 en la misma topología, probablemente 
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asignaría una clasificación de 1 a la clase a la entidad de GPS y una clasificación 

de 5 a la clase de entidad de origen de escala 1:1.000.000. Si fuera a validar la 

topología, las partes de entidades que entran dentro de la tolerancia clúster se 

alinearían conjuntamente, desplazando las menos precisas a la ubicación de las 

más precisas. Las entidades de GPS no se desplazarían a la posición de las 

entidades de la escala 1:1.000.000. 

Puede asignar hasta 50 clasificaciones diferentes, siendo 1 la clasificación de nivel 

superior. En esta topología, supondrá que todas las clases de entidad se basan en 

datos de la misma precisión, de modo que no asignara más de una clasificación. 

Parcels y Blocks tienen niveles equivalentes de precisión, dado que la clase de 

entidad Blocks se derivó de las entidades de parcela. 

9. Escriba 1 en el número de clasificaciones. 

10.  Haga clic en Siguiente. 

11. Haga clic en Agregar regla. 

Las reglas de topología le permiten definir relaciones espaciales de entidades 

permisibles dentro de clases de entidad y entre clases de entidad que participan en 

la topología. 

Normalmente no se permite que las parcelas de propiedad de terreno se 

superpongan. Agregará una regla para evitar que las entidades de parcelas se 

superpongan. 

12. Haga clic en la flecha de la lista desplegable Entidades de la clase de entidad y 

haga clic en Parcels.  

13. Haga clic en la flecha de la lista desplegable Regla y haga clic en No debe 

superponerse.  

14.  Haga clic en Aceptar. 

A continuación, creará una regla topológica que regirá la relación topológica de 

entidades en subtipos particulares de dos clases de entidad diferentes. En concreto, 

se asegurará de que esas parcelas residenciales están cubiertas por bloques o 

contenidas dentro de bloques también designados como residenciales. 

15.  Haga clic en Agregar regla. 

16. Haga clic en la flecha de lista desplegable Entidades de la clase de entidad, haga 

clic en el signo más para expandir Parcels, a continuación, haga clic en Residential. 

Residential es un subtipo de la clase de entidad Parcels que utiliza el departamento 

de la planificación para representar las parcelas donde viven las personas. 
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17. Haga clic en la flecha de lista desplegable Regla y haga clic en Debe Cubrirse Por. 

18. Haga clic en la flecha de lista desplegable Clase de entidad, haga clic en el signo 

más para expandir Blocks y, a continuación, haga clic en Residential. 

19. Haga clic en Aceptar. 

La regla topológica se agrega a la lista de reglas para esta topología 

20. Haga clic en Siguiente 

21. Revise la información de resumen de la topología para asegurarse de que es 

correcta. 

22.   Haga clic en Finalizar. 

Una vez creada la topología, tiene la oportunidad de validarla. No necesita validar 

la topología inmediatamente después de crearla. Dependiendo de los datos y del 

flujo de trabajo, puede que sea conveniente asignar áreas diferentes a los editores 

de datos para validarlas y editarlas en ArcMap. 

23. Haga clic en No. 

24. La topología aparece en el dataset de entidades Landbase. 
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